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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified in this document in 2 
order to describe an experimental procedure or concept adequately. Such identification is not intended 3 
to imply special status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; 4 
neither is it intended to imply that entities, equipment, products, or materials are necessarily the best 5 
available for the purpose.  6 

While NIST and the NCCoE address goals of improving management of cybersecurity and privacy risk 7 
through outreach and application of standards and best practices, it is the stakeholder’s responsibility to 8 
fully perform a risk assessment to include the current threat, vulnerabilities, likelihood of a compromise, 9 
and the impact should the threat be realized before adopting cybersecurity measures such as this 10 
recommendation. 11 

Domain name and IP addresses shown in this guide represent an example domain and network 12 
environment to demonstrate the NCCoE project use case scenarios and the security capabilities. 13 

National Institute of Standards and Technology Special Publication 1800-10C, Natl. Inst. Stand. Technol. 14 
Spec. Publ. 1800-10C, 128 pages, September 2021 15 

 

FEEDBACK 16 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 17 
own organization, we ask you and your colleagues to share your experience and advice with us.  18 

Comments on this publication may be submitted to: manufacturing_nccoe@nist.gov. 19 

Public comment period: September 23, 2021 through November 07, 2021 20 

All comments are subject to release under the Freedom of Information Act (FOIA).  21 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 28 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 29 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 30 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 31 
public-private partnership enables the creation of practical cybersecurity solutions for specific 32 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 33 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 34 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 35 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 36 
solutions using commercially available technology. The NCCoE documents these example solutions in 37 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 38 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 39 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 40 
Maryland. 41 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 42 
https://www.nist.gov 43 

NIST CYBERSECURITY PRACTICE GUIDES 44 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 45 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 46 
adoption of standards-based approaches to cybersecurity. They show members of the information 47 
security community how to implement example solutions that help them align more easily with relevant 48 
standards and best practices, and provide users with the materials lists, configuration files, and other 49 
information they need to implement a similar approach.  50 

The documents in this series describe example implementations of cybersecurity practices that 51 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 52 
or mandatory practices, nor do they carry statutory authority.  53 

ABSTRACT 54 

Today’s manufacturing organizations rely on industrial control systems (ICS) to conduct their operations. 55 
Increasingly, ICS are facing more frequent, sophisticated cyber attacks—making manufacturing the 56 
second-most targeted industry (C. Singleton et al., X-Force Threat Intelligence Index 2021, IBM, February 57 
2021, https://www.ibm.com/security/data-breach/threat-intelligence). Cyber attacks against ICS 58 
threaten operations and worker safety, resulting in financial loss and harm to the organization’s 59 
reputation.  60 

The architecture and solutions presented in this guide are built upon standards-based, commercially 61 
available products, and represent some of the possible solutions. The solutions implement standard 62 
cybersecurity capabilities, such as behavioral anomaly detection, application allowlisting, file integrity-63 
checking, change control management, and user authentication and authorization. The solution was 64 
tested in two distinct lab settings: a discrete manufacturing work cell, which represents an assembly line 65 

https://www.nccoe.nist.gov/
https://www.nist.gov/
https://www.ibm.com/security/data-breach/threat-intelligence


DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments iii 

production, and a continuous process control system, which represents chemical manufacturing 66 
industries. 67 

Organizations that are interested in protecting the integrity of the manufacturing system and 68 
information from destructive malware, insider threats, and unauthorized software should first conduct a 69 
risk assessment and determine the appropriate security capabilities required to mitigate those risks. 70 
Once the security capabilities are identified, the sample architecture and solution presented in this 71 
document may be used. 72 

The security capabilities of the example solution are mapped to NIST’s Cybersecurity Framework, the 73 
National Initiative for Cybersecurity Education Framework, and NIST Special Publication 800-53. 74 

KEYWORDS 75 

Manufacturing; industrial control systems; application allowlisting; file integrity checking; user 76 
authentication; user authorization; behavioral anomaly detection; remote access; software modification; 77 
firmware modification. 78 
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Cooperative Research and Development Agreement (CRADA) with NIST, allowing them to participate in 83 
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DOCUMENT CONVENTIONS  85 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 86 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 87 
among several possibilities, one is recommended as particularly suitable without mentioning or 88 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 89 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 90 
“may” and “need not” indicate a course of action permissible within the limits of the publication. The 91 
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 92 

CALL FOR PATENT CLAIMS 93 

This public review includes a call for information on essential patent claims (claims whose use would be 94 
required for compliance with the guidance or requirements in this Information Technology Laboratory 95 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 96 
or by reference to another publication. This call also includes disclosure, where known, of the existence 97 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 98 
unexpired U.S. or foreign patents. 99 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in 100 
written or electronic form, either: 101 

https://www.vmware.com/products/carbon-black-cloud-endpoint.html
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a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not 102 
currently intend holding any essential patent claim(s); or 103 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring 104 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 105 
publication either: 106 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination; 107 
or 108 

2. without compensation and under reasonable terms and conditions that are demonstrably free 109 
of any unfair discrimination.  110 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 111 
behalf) will include in any documents transferring ownership of patents subject to the assurance, 112 
provisions sufficient to ensure that the commitments in the assurance are binding on the transferee, 113 
and that the transferee will similarly include appropriate provisions in the event of future transfers with 114 
the goal of binding each successor-in-interest.  115 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 116 
whether such provisions are included in the relevant transfer documents.  117 

Such statements should be addressed to: manufacturing_nccoe@nist.gov 118 
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1 Introduction 305 

The following volume of this guide show information technology (IT) professionals and security 306 
engineers how we implemented this example solution. We cover all the products employed in this 307 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 308 
to be widely available. Rather, these volumes show how we incorporated the products together in our 309 
environment. 310 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 311 
for these products that are out of scope for this reference design. 312 

1.1 How to Use this Guide 313 

This NIST Cybersecurity Practice Guide demonstrates a modular design and provides users with the 314 
information they need to replicate the described manufacturing industrial control system (ICS) security 315 
solutions, specifically focusing on information and system integrity. This reference design is modular and 316 
can be deployed in whole or in part. 317 

This guide contains three volumes: 318 

 NIST SP 1800-10A: Executive Summary 319 

 NIST SP 1800-10B: Approach, Architecture, and Security Characteristics – what we built and why 320 

 NIST SP 1800-10C: How-To Guides – instructions for building the example solution (this 321 
document) 322 

Depending on your role in your organization, you might use this guide in different ways: 323 

Senior information technology (IT) executives, including chief information security and technology 324 
officers, will be interested in the Executive Summary, NIST SP 1800-10A, which describes the following 325 
topics: 326 

 challenges that enterprises face in ICS environments in the manufacturing sector 327 

 example solution built at the NCCoE 328 

 benefits of adopting the example solution 329 

Technology or security program managers might share the Executive Summary, NIST SP 1800-10A, with 330 
your leadership to help them understand the importance of adopting a standards-based solution. Doing 331 
so can strengthen their information and system integrity practices by leveraging capabilities that may 332 
already exist within their operating environment or by implementing new capabilities.  333 

Technology or security program managers who are concerned with how to identify, understand, assess, 334 
and mitigate risk will be interested in NIST SP 1800-10B, which describes what we did and why. The 335 
following sections will be of particular interest: 336 

 Section 3.4.1, Security Control Map, maps the security characteristics of this example solution to 337 
cybersecurity standards and best practices. 338 

 IT professionals who want to implement an approach like this will find this whole practice guide 339 
useful. You can use this How-To portion of the guide, NIST SP 1800-10C, to replicate all or parts 340 
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of the build created in our lab. This How-To portion of the guide provides specific product 341 
installation, configuration, and integration instructions for implementing the example solution. 342 
We do not recreate the product manufacturers’ documentation, which is generally widely 343 
available. Rather, we show how we incorporated the products together in our environment to 344 
create an example solution. 345 

This guide assumes that IT professionals have experience implementing security products within the 346 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 347 
not endorse any products. Your organization can adopt this solution or one that adheres to these 348 
guidelines in whole, or you can use this guide as a starting point for tailoring and implementing parts of 349 
this manufacturing ICS solution. Your organization’s security experts should identify the products that 350 
will best integrate with your existing tools and IT system infrastructure. We hope that you will seek 351 
products that are congruent with applicable standards and best practices. Section 3.5, Technologies, in 352 
NIST SP 1800-10B, lists the products that we used and maps them to the cybersecurity controls provided 353 
by this reference solution. 354 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 355 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 356 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 357 
manufacturing_nccoe@nist.gov. 358 

1.1 Build Overview 359 

The NCCoE partnered with NIST’s Engineering Laboratory (EL) to provide real-world scenarios that could 360 
happen in ICS in the manufacturing sector. This collaboration spawned four unique builds: two builds 361 
within the Collaborative Robotics (CRS) environment and two builds within the Process Control System 362 
(PCS) environment. For each build, the NCCoE and the EL performed eleven scenarios. The step-by-step 363 
instructions on how each product was installed and configured in this lab environment are outlined in 364 
this document. For more information on the two environments refer to Section 4.5 in NIST SP 1800-10B. 365 
Additionally, Appendix B of this Volume contains the four build architecture diagrams for reference. 366 

1.2 Typographic Conventions 367 

The following table presents typographic conventions used in this volume. 368 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, on-
screen computer output, 
sample code examples, and 
status codes 

mkdir 

mailto:manufacturing_nccoe@nist.gov
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Typeface/Symbol Meaning Example 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the doc-
ument, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.3 Logical Architecture Summary 369 

The security mechanisms and technologies were integrated into the existing NIST Cybersecurity for 370 
Smart Manufacturing Systems (CSMS) lab environment. This cybersecurity performance testbed for ICS 371 
is comprised of the PCS and the CRS environments along with additional networking capabilities to 372 
emulate common manufacturing environments. For more information see An Industrial Control System 373 
Cybersecurity Performance Testbed, NISTIR 8089, 374 
http://nvlpubs.nist.gov/nistpubs/ir/2015/NIST.IR.8089.pdf. 375 

Typically, manufacturing organizations have unique cyber-ecosystems and specific needs for their 376 
operations. To demonstrate the modularity and interoperability of the provided solutions, this project 377 
used available Cooperative Research and Development Agreement (CRADA) partner technologies to 378 
assemble four “builds” deployed across both the PCS and CRS. Additionally, to increase the diversity of 379 
technologies between builds, two of the builds also utilized open source solutions (Security Onion 380 
Wazuh), native operating system features (Windows Software Restriction Policies [SRP]), and a Cisco 381 
Adaptive Security Appliance (ASA) device configured with the AnyConnect VPN client.  382 

Figure 1-1 depicts a high-level architecture for the demonstration environment consisting of a Testbed 383 
Local Area Network (LAN), a demilitarized zone (DMZ), the PCS, and the CRS. The environment utilizes a 384 
combination of physical and virtual systems and maintains a local network time protocol (NTP) server 385 
for time synchronization. Additionally, the environment utilizes virtualized Active Directory (AD) servers 386 
for domain services. The tools used to support information and system integrity are deployed and 387 
integrated in the DMZ, Testbed LAN, PCS, and CRS per vendor recommendations and standard practices 388 
as described in the detailed sections for each build.  389 

https://www.nccoe.nist.gov/
http://nvlpubs.nist.gov/nistpubs/ir/2015/NIST.IR.8089.pdf
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Figure 1-1: CSMS Network Architecture 390 
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In summary, there are six networks within the CSMS architecture: 391 

Testbed LAN: This network is where the majority of the collaborators’ products are installed. This LAN 392 
has access to the PCS and CRS environments. Other systems, such as AD, an NTP server, and a Windows 393 
server, are also located on this LAN. The Testbed LAN has three gateways to other network segments, 394 
including 10.100.0.1 to reach the DMZ and the corporate network, 10.100.0.20 as a network address 395 
translation (NAT) interface to the CRS environment, and 10.100.0.40 as the gateway to the PCS 396 
environment. 397 

DMZ: A demilitarized zone that separates the corporate network from the operational technology (OT) 398 
network. Many of the collaborators’ products are also installed in the DMZ. The DMZ is used across the 399 
PCS and CRS environments. 400 

PCS Virtual Local Area Network (VLAN) 1: This is the operations LAN within the PCS environment. This 401 
LAN simulates a central control room environment. The gateway interface for this network segment is 402 
172.16.1.1 403 

PCS VLAN 2: This is the supervisory LAN within the PCS environment. This LAN simulates the process 404 
operation/manufacturing environment, which consists of the operating plant, programmable logic 405 
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controller (PLC)s, object linking and embedding for process control (OPC) server, and data historian. The 406 
gateway interface for this network segment is 172.16.2.1 407 

CRS Supervisory LAN: This LAN is within the CRS environment. The historian, PLCs, operating human 408 
machine interface (HMI), Engineering workstation, and remote input/output devices are connected to 409 
this network. The gateway interface for this network segment is 192.168.0.2 410 

CRS Control LAN: This LAN is within the CRS environment. The robot controllers and manufacturing 411 
station controllers are connected to this network. The gateway interface for this network segment is 412 
192.168.1.2 413 

The test bed networks used static IPv4 addresses exclusively, and the subnet masks were set to 414 
255.255.255.0. No IPv6 addresses were used. This setup is consistent with industry practice. Specific 415 
Internet Protocol (IP) addresses are listed for each component in the following sections. 416 

For an in-depth view of the architectures PCS and CRS builds, specific build architecture diagrams can be 417 
found in Volume B of this practice guide, Section 4.3, Process Control System, and Section 4.4, 418 
Collaborative Robotics System. 419 

2 Product Installation Guides 420 

This section of the practice guide contains detailed instructions for installing and configuring all the 421 
products used to build the example solutions. 422 

2.1 Dispel Remote Access 423 

Dispel is a remote access tool for OT environments that provides secure remote access to the industrial 424 
networks. Dispel, implemented in Build 2 and Build 4, uses cloud-based virtual desktop interfaces (VDIs) 425 
that traverse a cloud-based Enclave to reach a Wicket ESI device that is deployed within the local OT 426 
network. Dispel supports both user authentication and authorization, and remote access for Builds 2 427 
and 4. 428 

Virtual Desktop Interfaces (VDIs) 429 

VDIs are Virtual Machines (VMs) that reside in the cloud and allow users to connect using Remote 430 
Desktop Protocol (RDP). The VDIs establish a secure connection to the Wicket ESI located in the OT 431 
network to provide network access to the OT devices.  432 

Enclave 433 

Enclaves are single-tenanted, colorless core, moving target defense (MTD) networks. Enclaves are 434 
composed of VMs that act as traffic nodes. To create a shifting target profile, these VMs are steadily 435 
replaced by new VMs launched on different hypervisors, in different geographic regions, and/or on 436 
altogether different public or private clouds. In the case of Builds 2 and 4, the Enclaves were launched 437 
exclusively on public clouds. To provide a static set of IP addresses throughout the builds, the MTD 438 
characteristic was disabled.  439 
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Wicket ESI 440 

Wicket ESIs are on-premise components, shown in Figure 2-1, that allows users to connect to the OT 441 
network remotely. These devices establish encrypted connections from the local OT network up to an 442 
Enclave which, in turn, is connected to the VDI, allowing a remote user to access the OT devices.  443 

Additional information is available in Remote Access for Industrial Control Systems from Dispel.io at: 444 
https://s3.amazonaws.com/downloads.dispel.io/resources/One+Pager/dispel-ics-445 
brochure_20190529.pdf 446 

Figure 2-1 Dispel High-level Implementation, from Remote Access for ICS  447 

 

2.1.1 Host and Network Configuration 448 

The Wicket ESI is connected to two ports within the DMZ, one for supporting outbound communications 449 
to the Dispel Enclave (labeled “WAN”) and one for supporting communication through the local firewall 450 
to the ICS environment (labeled “LAN”). The items listed in Table 2-1 are the Wicket ESI specific device 451 
and network settings for the hardware provided to support Build 2 Figure B-2 and 4 Figure B-4. 452 

Table 2-1 Dispel Deployment 453 

Name System OS CPU Memory Storage Network 

Dispel Wicket 
ESI 

ONLOGIC, 
ML340G-51 

Ubuntu 16.04 Intel i5-
6300U 

16GB 120GB Wicket WAN 
Interface  
10.100.1.60 
Wicket LAN 
Interface 
10.100.1.61 
DMZ 

Dispel Enclave Cloud Virtual 
Machines 

Ubuntu 16.04 Variable Variable Variable N/A 

Dispel VDI Cloud Virtual 
Machine 

Windows Server 
2016 

Intel 
Xeon 
Platinum 
8171M 

8GB 120GB N/A 

 

https://s3.amazonaws.com/downloads.dispel.io/resources/One+Pager/dispel-ics-brochure_20190529.pdf
https://s3.amazonaws.com/downloads.dispel.io/resources/One+Pager/dispel-ics-brochure_20190529.pdf
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2.1.2 Installation 454 

Installation involves establishing an account on the Dispel cloud-infrastructure and deploying the 455 
preconfigured Wicket ESI device within the OT environment. Detailed installation information, 456 
customized to the end user’s deployment, is provided by Dispel. 457 

After connecting the WAN and LAN network cables, configuring the Wicket ESI required connecting a 458 
monitor, keyboard, and mouse to the unit using the available VGA and USB ports. Logging into the unit 459 
locally using the credentials provided by Dispel enabled configuration of the network connections using 460 
the following procedure (note: these procedures were executed using root privileges and can also be 461 
performed using Sudo). 462 

1. Update the network interfaces with the IP configuration information: 463 

#> vi /etc/network/interfaces 464 

source-directory /etc/network/interfaces.d 
# LAN 
auto enp4s0 
allow-hotplug enp4s0 
iface enp4s0 inet static 
 address 10.100.1.61 
 netmask 255.255.255.0 
 #gateway  
 up route add -net 10.100.0.0 netmask 255.255.255.0 gw 10.100.1.1 dev 
enp4s0 
 up route add -net 172.16.0.0 netmask 255.255.252.0 gw 10.100.1.1 dev 
enp4s0 
 
# WAN 
auto enp0s31f6 
allow-hotplug enp0s31f6 
iface enp0s31f6 inet static 
 address 10.100.1.60 
 netmask 255.255.255.0 
 gateway 10.100.1.1 
 dns-nameservers <ip address> 

 

2. Update the Wicket ESI netcutter.cfg file to include the local subnet information (toward the 465 
bottom of the file): 466 

#> vi /home/ubuntu/wicket/netcutter.cfg 467 

… 
subnets = (  
  { 
    name = "Default"; 
    value = "10.100.0.0/24"; 
    advertise = "false"; 
  },  
  { 
    name = "PCS"; 
    value = "172.16.0.0/22"; 
    advertise = "false"; 
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  },  
  { 
    name = "DMZ"; 
    value = "10.100.1.0/24"; 
    advertise = "false"; 
  } ); 

 

3. Restart the Wicket services with the following command: 468 

#> service wicket restart 469 

4. Check the log for errors and test connectivity to the Dispel environment (note: IP address will be 470 
account specific): 471 

#> tail -f /home/ubuntu/wicket/wicket.log 472 

2.1.3 Configuration 473 

With the Wicket ESI connected to the lab environment, the solution may be configured by establishing 474 
an account and configuring the cloud infrastructure, configuring the corporate router/firewall to allow 475 
authorized connections to and from the Wicket ESI, and configuring the VDI environment to support the 476 
remote access to the ICS environments.  477 

For full documentation and configuration instructions, see the Dispel documentation at 478 
https://intercom.help/dispel/en/. 479 

Dispel created an organization named “NCCOE” with an Enclave name “NCCoE-Manufacturing” in their 480 
pre-production staging environment. A single “user” account was created for accessing the cloud 481 
infrastructure environment named nccoe-m-user@dispel.io. Organizations will need to plan for 482 
implementing multiple accounts for supporting the “owner” and “admin” roles in addition to the “user” 483 
roles. The “owner” and “admin” roles are for monitoring and managing the cloud infrastructure and are 484 
separate from the user accounts used to login to the VDI environment.  485 

The staging environment was configured without the Dispel multifactor authentication (MFA) settings 486 
because personal identity verification (PIV) cards were not available as a supported mechanism, and the 487 
lab environment did not support authenticator application or security keys. However, MFA is very 488 
important for implementation and is strongly encouraged when planning the implementation. For this 489 
effort, to reduce the risk of not having the MFA implementation, NCCoE worked with Dispel to limit 490 
access to the cloud infrastructure and the VDI instances to only approved source IP addresses. The 491 
additional protection of restricting access to the cloud infrastructure and VDI instances is also 492 
encouraged to reduce the risks associated with the internet-accessible web and RDP services. 493 

Configure Firewall Settings: 494 

The Wicket ESI needs access to the internet and to the internal OT environment. Table 2-2 below 495 
describes the firewall rules implemented on the corporate router/firewall for communications on the 496 
internet-facing firewall and internal network zone firewall.  497 

https://intercom.help/dispel/en/
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Table 2-2 Firewall Rules for Dispel 498 

Rule Type Source Destination Protocol:Port(s) Purpose 

Allow 10.100.1.60 IdAM: 
159.65.111.193 
Entry Node: 
52.162.177.202 

TCP/UDP:1194, 
HTTPS 

Outbound Secure Web to Dis-
pel Environment on the Inter-
net 

Allow 10.100.1.61 10.100.1.0/24 ICMP 
TCP/UDP:RDP, SSH, 
HTTP/HTTPS, SMB, 
NTP 

PLC Controller Scans 

Allow 10.100.1.61 Security Onion 
10.100.0.26 

TCP:1515 
UDP:1514 

Build 2: Communication be-
tween Wazuh Agent and the 
server 

Allow 10.100.1.61 172.16.0.0/22 TCP:RDP, 
HTTP/HTTPS 

Build 2: Authorized Inbound 
Communications to PCS Envi-
ronment 

Allow 10.100.1.61 Carbon Black 
10.100.0.52 

TCP:41002 Build 4: Communication port 
used between Carbon Black 
Agent and the server 

Allow 10.100.1.61 CRS NAT 
10.100.0.20 

TCP:48898 
UDP:48899 

Build 4: Inbound Automation 
Device Specification (ADS) 
Protocol for Communication 
with PLC Device 

 

Notes:  499 

 Dispel’s recommended rule for allowing secure shell (SSH)for installation and remote support 500 
from the Dispel environment was not enabled for this effort. 501 

 The rules implemented included restricting these outbound ports to Enclave specific IP 502 
addresses. 503 

 The Enclave’s MTD characteristics were disabled to keep the Enclave’s IP addresses static for the 504 
duration of the project. 505 

Configure Virtual Desktop Infrastructure (VDI): 506 

The VDI instance is a fully functional workstation/server within the cloud environment. From the 507 
VDI instance, authorized users establish a VPN tunnel to the Wicket ESI within the OT 508 
environment and then have the access to the environment configured by the device and firewall 509 
configurations. In this effort, NCCoE implanted the VDI configuration to support Build 2 and 510 
Build 4. The configuration supports the OT environment’s jump server configuration (allowing 511 
RDP and SSH access to systems within the PCS and CRS environment) and remote engineering 512 
workstation (configuring the VDI with the tools needed to support the ICS environment). The 513 
configuration for each build is detailed in the following sections. 514 
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1. Build 2: PCS Configuration 515 
i. For the PCS setup, the Dispel VDI was used in a jump server configuration. No 516 

additional software was installed. The firewall and Wicket ESI configuration 517 
allowed RDP and SSH connections to the PCS ICS environment. Additionally, RDP, 518 
SSH, and HTTP/HTTPS access to the Cybersecurity LAN environment was 519 
authorized for the remote sessions as defined in the previously described firewall 520 
settings, Table 2-2. 521 

2. Build 4: CRS Configuration 522 
i. For the CRS setup, the Dispel VDI was configured as a remote engineering 523 

workstation. To support the Beckhoff PLC, the TwinCAT 3 XAE software was 524 
installed on a VDI, and the network drive provided by the GreenTec-USA solution 525 
and hosted in the DMZ environment that contained the PLC code was mapped to 526 
the VDI. Additionally, RDP, SSH, and HTTP/HTTPS access to the Cybersecurity LAN 527 
environment was authorized for the remote sessions as defined in the previously 528 
described firewall settings, Table 2-2. 529 

ii. For the interaction with the Beckhoff PLC, the TwinCAT 3 XAE software (TC31-530 
FULL-Setup.3.1.4024.10.exe) was installed on the VDI. 531 

iii. The Dispel VPN connection does not allow split-tunneling so, once the VPN 532 
connection is established from the VDI to the Wicket ESI, the VDI is disconnected 533 
from the internet. Therefore, download and installation of software occurred 534 
prior to connecting to the Wicket ESI. 535 

iv. Due to the NAT configuration of the RUGGEDCOM RX1510 router between the 536 
Cybersecurity LAN and the CRS environment, port forwarding rules were 537 
configured to allow external traffic to reach the Beckhoff CX9020 PLC. 538 

v. The following rules (Table 2-3) were created in the RX1510 firewall to enable 539 
destination network address translation (DNAT) from the firewall WAN interface 540 
(10.100.0.20) to the CRS PLC (192.168.0.30) 541 

Table 2-3 Firewall Rules 542 

Rule Type Source Destination Destination Port(s) Purpose 

DNAT 10.100.1.61 192.168.0.30 UDP:48899 DNAT (10.100.0.20) - Beckhoff 
ADS discovery protocol used 
by the TwinCAT 3 software to 
discover ADS devices. 

DNAT 10.100.1.61 192.168.0.30 TCP:48898 DNAT (10.100.0.20) - Beckhoff 
ADS protocol used by the 
TwinCAT 3 software to com-
municate with the PLC. 
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3. As described in 2.i above, the GreenTec WORMdisk (\\10.100.1.7\crs) was mapped to the 543 
VDI to access the PLC code. The configuration to map Windows is shown in Figure 2-2 544 
below: 545 

Figure 2-2 Mapping a Network Drive 546 

 

4. After clicking Finish, the user is prompted for credentials, as shown in Figure 2-3. An account 547 
authorized to access the network drive must be used. This is separate from the Dispel VDI 548 
credentials.  549 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 12 

Figure 2-3 Authentication to File Server 550 

 

2.2 Dragos 551 

The Dragos platform implementation in Build 3 consists of two physical servers hosting the Dragos 552 
SiteStore and the Dragos sensor to meet the behavioral anomaly detection (BAD), hardware 553 
modification, firmware modification, and software modification capabilities. Dragos utilizes a 554 
combination of a passive sensor and integration with the OSIsoft PI Server to monitor critical networks 555 
for anomalies. OSIsoft PI performs active querying to retrieve information about endpoints in the CRS 556 
environment, which is shared with Dragos. 557 

2.2.1 Host and Network Configuration 558 

Dragos is installed and configured to support the CRS Environment in Build 3. The overall build 559 
architecture is shown in Figure B-3, and the Dragos specific components are listed in Table 2-4. 560 

Table 2-4 Dragos Deployment 561 

Name System OS CPU Memory Storage Network 

VMware 
Server 

Dell OEMR 
R740  

VMware 6.7.0 
Update 3 

2x Intel 
6130 CPU 

384 GB 2x 1.5TB 
Mirror 
6x 8TB 
RAID 10 

Testbed LAN 
10.100.0.62/24 

Dragos Server VMware CentOS 7 48x vCPU 192 GB 215 GB 
10 GB 1.5 
TB 1.5 TB 

Testbed LAN 
10.100.0.63/24 

Dragos Sensor Dell OEM CentOS 7 64x vCPU 128 GB 240 GB 
1 TB 

Testbed LAN 
10.100.0.64/24 
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2.2.2 Installation 562 

The Dragos platform, which includes the SiteStore server and the Dragos sensor, was delivered as pre-563 
configured hardware appliance by Dragos with the required IP addresses already assigned. The only 564 
installation step was correctly connecting the server and the sensor management ports to the Testbed 565 
LAN and adding the switch port analyzer (SPAN) port connection to the sensor. 566 

The Dragos Platform Administrator Guide and Dragos Platform User Guide for Release 1.7 were used to 567 
guide the installation. Customers can obtain these guides from Dragos.  568 

2.2.3 Configuration 569 

In addition to the standard configuration preset by Dragos, the Dragos Platform was configured to work 570 
with OSIsoft PI for alerting on certain conditions.  571 

Configure the Dragos SiteStore Server: 572 

1. Configure the data connection between Dragos SiteStore and OSIsoft PI Server: 573 

a. Once installation is successful, open a browser to access the configuration screen by us-574 
ing the URL https://<SiteStore ip address>/osisoft/#/apps. (Figure 2-4) 575 

Figure 2-4 Dragos OSIsoft PI Server Integration 576 

 

b. Click Configuration Pi Web API to open a screen for filling out the required information, 577 
including privacy enhanced mail (PEM) format certificate and password for secure 578 
authentication (Figure 2-5). 579 

i. Upload the server public key for the HTTPS certificate. 580 

ii. Specify the user credentials for the OSIsoft PI Web API interface. 581 
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iii. Click Save. 582 

Figure 2-5 Dragos PI Web API Configuration 583 

 584 

c. Click Map Elements to access the interface to pair elements between OSIsoft PI Server 585 
and the Dragos Platform assets. Here, the PLC in OSIsoft Elements panel is paired with 586 
Beckhoff asset in the Dragos Platform asset (Figure 2-6). 587 

i. Select the OSIsoft Database CRS-backup on the left side to access the devices list 588 
from the Historian Database. 589 

ii. Select the Default NetworkID RFC 1918 and use the Filer options to find specific 590 
assets. 591 

iii. For each asset in the OSIsoft Database, select the corresponding asset in the Dra-592 
gos asset repository and click Pair Selected. 593 

iv. Repeat this process for each asset until all paired assets are listed in the Paired 594 
Data table (Figure 2-7). 595 

1) PLC paired to 192.168.0.30 596 

2) Station 1 paired to 192.168.1.101 597 

3) Station 2 paired to 192.168.1.102 598 

4) Station 3 paired to 192.168.1.103 599 

5) Station 4 paired to 192.168.1.104 600 
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Figure 2-6 OSIsoft PI Server to Dragos Asset and Data Pairing 601 

 602 

Figure 2-7 OSIsoft PI Server and Dragos Paired Data Elements 603 

 604 

a. Configure Zones 605 

NOTE: Zones are ordered in a similar manner to firewall rules. In other words, higher rules 606 
have priority over lower rules. 607 

i. Click Assets and select the Zones tab (Figure 2-8). 608 
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Figure 2-8 Dragos Zone Administration Page 609 

 

b. Click + New Zone (Figure 2-9) and define the following zones:  610 

i. Name: DMZ: 611 

1) Description: Lab DMZ 612 
2) Zone Criteria (Match ALL): 613 

a) IPV4 CIDR Matches CIDR 10.100.1.0/24 614 

ii. Name: Testbed LAN: 615 

1) Description: Lab Testbed LAN 616 

2) Auto Zone Criteria (Match ALL): 617 

a) IPV4 CIDR Matches CIDR 10.100.0.0/24 618 

iii. Name: CRS: 619 

1) Description: Parent CRS 620 

2) No Criteria 621 

iv. Name: CRS – Level 0: 622 

1) Description: Robots and Controllers 623 

2) Parent Zone: CRS 624 

3) Auto Zone Criteria (Match ALL): 625 

a) IPV4 CIDR Matches CIDR 192.168.1.0/24 626 
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v. Name: CRS – Level 1: 627 

1) Description: Lab DMZ 628 

2) Parent Zone: CRS 629 

3) Auto Zone Criteria (Match ALL): 630 

a) IPV4 CIDR Matches CIDR 192.168.0.0/24 631 

Figure 2-9 Dragos Create Zone Pop-up 632 

 

2.3 Forescout Platform 633 

The Forescout products included in the practice guide are eyeInspect (formally SilentDefense), eyeSight, 634 
ICS Patrol, and Forescout Console. These products are utilized in Build 2 to meet the BAD, hardware 635 
modification, firmware modification, and software modification capabilities. The Forescout 636 
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implementation utilizes different components and modules installed on different devices to monitor 637 
critical networks for anomalies and active query capabilities to retrieve information about endpoints in 638 
the PCS environment. A high-level of the key server and agent components is presented in Figure 2-10. 639 

Figure 2-10 Forescout High-Level Components and Dataflows 640 

 

eyeInspect (formally SilentDefense)  641 

The eyeInspect (Version 4.1.2) control server and monitoring sensor are installed on a single appliance 642 
with a management interface on the Testbed VLAN and network monitoring capabilities through a 643 
dedicated SPAN port. The SPAN port provides passive monitoring for network-based anomalies and 644 
retrieves information about endpoints within the network. The eyeInspect appliance also serves as the 645 
command center for supporting the ICS Patrol and eyeSight components. 646 

eyeSight 647 

Forescout eyeSight (Version 8.2.1) provides enhanced network monitoring and response using an agent 648 
installed on endpoints. In this build, eyeSight instances are configured through the Forescout Console to 649 
provide additional monitoring and reporting information to eyeInspect.  650 

ICS Patrol  651 

Forescout ICS Patrol (Version 1.1.2-4.a826b94) is a sensor that supports active queries for ICS devices to 652 
obtain status and other information such as hardware configuration and firmware version. ICS Patrol 653 
queries and reporting results are managed through eyeInspect. 654 

Forescout Console 655 
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The Forescout Console (Version 8.2.1) is a Java-based application for configuring and managing eyeSight 656 
and eyeSight agents. The Forescout Console is installed on a computer with network access to the 657 
eyeSight server. 658 

2.3.1 Host and Network Configuration 659 

Forescout was installed and configured to support the PCS Environment as part of Build 2. The overall 660 
build architecture is provided in Figure B-2 with the Forescout specific components in Table 2-5 and the 661 
eyeSight agents in Table 2-6. 662 

Table 2-5 Forescout Deployment 663 

Name System OS CPU Memory Storage Network 

eyeInspect 
control server 

Dell Embed-
ded Box PC 
5000 

Ubuntu 16.04 Intel i7-
6820EQ 

32 GB 250 GB Testbed LAN 
10.100.0.65 

Forescout 
Console 

Hyper-V VM Windows 2012R2 2x vCPU 6 GB 65 GB Testbed LAN 
10.100.0.25 

eyeSight 
Server 

Dell R640 Ubuntu 16.04.06 Intel 
Xeon Sil-
ver 4110 

32 600 GB PCS VLAN 2 
172.16.2.61 

ICS Patrol VirtualBox 
VM 

Ubuntu 16.04.06 2x vCPU 2 GB 40 GB PCS VLAN 2 
172.16.2.62 

 

For the lab environment, network connectivity between the components in the Testbed LAN and the 664 
components in the PCS environment required the following persistent route configured on Testbed LAN 665 
systems: 666 

route -p ADD 172.16.0.0 MASK 255.255.252.0 10.100.0.40 667 

The following systems were configured to utilize the eyeSight Agents.  668 

Table 2-6 eyeSight Agent Deployment 669 

Name System OS CPU Memory Storage Network 

Engineering 
Workstation 

Dell T5610 Windows 7 Intel i5-
4570 

16 GB 465 GB PCS VLAN 3 
172.16.3.10 

HMI Host Generic Windows 7 Intel i5-
4590 

8 GB 233 GB PCS VLAN 1 
172.16.1.4 

 

Additional details for Build 2 are available in Section 4.5 of Volume B. 670 
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2.3.2 Installation 671 

The Forescout products included in the practice guide are eyeInspect, Forescout Console, ICS Patrol, and 672 
eyeSight. These products are installed as indicated in the appropriate subsection below. To support 673 
these components, the PCS Gateway/Firewall rules were updated as follows (Table 2-7). 674 

Table 2-7 Firewall Rules for Forescout 675 

Rule Type Source Destination Port(s) Purpose 

Allow 10.100.0.65 172.16.2.61 22 (ssh) 
9999 
9092 

System Management 
eyeInspect Data 
eyeInspect Data 

Allow 10.100.0.65 172.16.2.62 22 (ssh) 
9001 

System Management 
eyeInspect Data 

 

2.3.2.1 eyeInspect  676 

eyeInspect is an appliance hosted on a Dell Embedded Box PC 5000. The unit was placed within a 677 
standard datacenter rack unit with the eyeSight appliance and connected to the network as described in 678 
Section 2.3.1. SPAN ports from the DMZ, Testbed LAN, and PCS VLAN 1, 2, and 3 switches were routed 679 
to the appliance for passive network monitoring. Installation also required uploading the license file 680 
after successfully logging onto the appliance. 681 

2.3.2.2 Forescout Console 682 

Forescout Console was installed following the standard installation procedures. Instructions can be 683 
found in the Forescout Installation Guide Version 8.2.1 available at https://docs.forescout.com. The 684 
software is available from https://forescout.force.com/support/s/downloads, where current and past 685 
versions are available. Login credentials were provided by Forescout. 686 

2.3.2.3 eyeSight 687 

Forescout eyeSight is an appliance hosted on a 1U Dell R640 that is installed within a standard 688 
datacenter rack and connected to the network as described in the previous section. 689 

2.3.2.4 eyeSight SecureConnector Agent 690 

1. In a browser on a system with web connectivity to the eyeSight server, navigate to 691 
https://172.16.2.61/sc.jsp to access the SecureConnector download page (Figure 2-11) and 692 
follow these steps: 693 

a. Select Create SecureConnector for: Windows.  694 

b. Enable Show the SecureConnector icon on the endpoint systray. 695 

c. Select Install Permanent As Service. 696 

d. Click Submit. 697 

https://docs.forescout.com/
https://forescout.force.com/support/s/downloads
https://172.16.2.61/sc.jsp
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2. Download the Forescout Agent (Figure 2-12): 698 

a. Select Version Win64. 699 

b. Click Download. 700 

3. Install the downloaded agent on the target systems using an administrator account. 701 

Figure 2-11 Forescout SecureConnector Distribution Tool 702 

 

Figure 2-12 Forescout Agent Download 703 

 

2.3.2.5 ICS Patrol  704 

Forescout ICS Patrol (Version 1.1.2-4.a826b94) is a sensor that is deployed on an existing VirtualBox host 705 
in the PCS environment. Ubuntu 16.04.06 is required for proper installation and can be downloaded 706 
from http://old-releases.ubuntu.com/releases/xenial/ubuntu-16.04.6-server-amd64.iso. Install the 707 
operating system on a VM connected to PCS VLAN 2 following the procedures from the Silent Defense 708 
Installation and Configuration Guide 4.1.2 document Section 2.2.2, Installing the Linux Ubuntu OS. 709 

1. Install the ICS Patrol Component from the Silent Defense Installation and Configuration Guide 710 
4.1.2 document Sections 2.2.4 and 2.2.5 following these steps: 711 

a. Establish an SSH session to the eyeInspect appliance. 712 

http://old-releases.ubuntu.com/releases/xenial/ubuntu-16.04.6-server-amd64.iso
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b. Copy the components to the ICS Patrol VM: 713 

$ scp os_provisioning_4.1.1_install.run \ 714 
main_configuration_4.1.1_install.run \ 715 
silentdefense@172.16.2.62:/home/silentdefense 716 

c. SSH to the ICS Patrol VM and execute the installation components: 717 

$ chmod a+x *.run  718 
$ sudo ./os provisioning 4.1.1 install.run 719 
$ sudo ./main_configuration_4.1.1_install.run 720 
$ sudo reboot 721 

2.3.3 Configuration 722 

The eyeSight agents and ICS Patrol do not require specific configurations.  723 

2.3.3.1 eyeInspect  724 

1. Access the eyeInspect web interface and log in with an administrator account. 725 

2. Register the local sensor for SPAN traffic monitoring: 726 

a. Click the Sensors option to access the Sensor Admin/Overview Page (Figure 2-13). 727 

b. Click the menu option Add > SilentDefense sensor. 728 

c. Specify the sensor parameters in the dialog box (Figure 2-14). 729 

Figure 2-13 eyeInspect Sensor Admin/Overview Page – Add Sensor 730 
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Figure 2-14 Adding a New SilentDefense Sensor Dialog 731 

 

3. Adjust Passive Monitoring settings: 732 

a. From the Dashboard, click Sensors. 733 

b. Select the SilentDefense Sensor from the list of available sensors. 734 

c. Click the Industrial Threat Library Overview option in the upper right corner. 735 

d. Click the Security menu option on the left under Checks by Category.  736 

e. Enter "ICMP" in the Search field to reduce the list of available options. 737 

f. Click the ICMP protocol/port scan attempt to open the settings dialog box ( Figure 2-15) 738 
and verify the following settings: 739 

i. Verify Enable Check is selected. 740 

ii. Verify Maximum occurrences in window is set to 20. 741 

iii. Verify Time Window (in seconds) is set to 60. 742 
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Figure 2-15 eyeInspect ICMP Protocol/Port Scan Attempt Settings 743 

 

g. Select Portscan Detection under Built-in Modules (Figure 2-16). 744 

Figure 2-16 eyeInspect Sensor Configuration Options 745 

 746 

h. Click the Settings tab and set the following parameters (Figure 2-17): 747 

i. Sensitivity level: User defined 748 

ii. Number of Hosts with failed connections to make a distributed scan: 10 749 

iii. Detect SYN scans: Checked 750 
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iv. Target detection probability: 0.99 751 

v. Target FP probability: 0.01 752 

vi. Detect ACK scans: Checked 753 

vii. Number of out of sequence ACK packets: 5 754 

Figure 2-17 eyeInspect Portscan Detection Settings 755 

 756 

4. Register the ICS Patrol Sensor: 757 

a. From the Sensor admin page, click the menu option Add > ICS Patrol sensor. 758 

b. Specify the sensor parameters in the dialog box (Figure 2-18). 759 
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Figure 2-18 Add ICS Patrol Sensor Dialog 760 

 

c. Define a scan policy to periodically check the PCS PLC to monitor for changes. 761 

i. Click the PCS Sensor created in the previous step to open the sensor admin page 762 
(Figure 2-19). 763 
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Figure 2-19 ICS Patrol Sensor Admin Page 764 

 

ii. Click the menu option Scans > Scan Policies. 765 

iii. In the dialog option (Figure 2-20) enter the scanning parameters: 766 

1) Name: PCS PLC 767 

2) Scan Type: EtherNet/IP 768 

3) Target Type: Custom target 769 

4) IP address reuse: No 770 

5) Network Address: 172.16.2.102 771 

6) Schedule: Yes 772 

7) Frequency: Repeat 773 

8) Interval: 1 . Select "Hours" from the drop-down menu. 774 

9) Click Finish. 775 
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Figure 2-20 Add an ICS Patrol Scan Policy 776 

 

2.3.3.2 eyeSight 777 

Using the Forescout Console application, users may configure, monitor, and manage the eyeSight 778 
appliance and agents. The Forescout Console is also used to test and verify connectivity to the 779 
eyeInspect server. 780 

1. Login to the Forescout Console. 781 

2. Select the Gear Icon in the upper right corner or the Tools > Option menu item to bring up the 782 
Options display. 783 

3. Enter "Operational" in the search bar. 784 

4. Select the Operational Technology tab on the left side of the screen to display the current 785 
settings. 786 

5. Select the IP entry for the Command Center and select Add to start the workflow process. 787 
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a. Specify General Information (Figure 2-21):  788 

i. Enter the Command Center IP Address "10.100.0.65" for IP Address/Name. 789 

ii. Select "172.16.2.61" from the Connecting CounterAct device drop-down menu. 790 

iii. Select "443" from the TCP Port drop-down menu. 791 

Figure 2-21 eyeSight Add Dialog – General Information 792 

 

b. Click Next. 793 

c. Enter the command center credentials (Figure 2-22). 794 

d. Click Finish. 795 
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Figure 2-22 eyeSight Add – Command Center Credentials 796 

 

6. Select the IP address for the Command Center and Click Test (Figure 2-23). If the connection is 797 
successful, a message like the one shown in Figure 2-24 is displayed. 798 

7. Click Apply to save the changes. 799 

8. Click Close to close the message. 800 
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Figure 2-23 eyeSight OT Settings 801 

 

Figure 2-24 eyeSight Test Connection Successful Message 802 

 

2.4 GreenTec-USA 803 

The GreenTec-USA products included in this practice guide are the ForceField and WORMdisk zero trust 804 
storage devices. These products were utilized in Builds 1, 2, 3, and 4 to meet the File Integrity Checking 805 
capability by storing and protecting critical PCS and CRS data from modification and deletion.  806 
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ForceField 807 

A ForceField hard disk drive (HDD) provides a protected write-once-read-many data storage location for 808 
historian data backups and database backups. Data is immediately protected as it is written to the HDD 809 
in real time, permanently preventing the data from modification and deletion.  810 

WORMdisk 811 

A WORMdisk HDD provides a protected data storage location for PLC logic, device firmware, and 812 
approved software applications for use in the manufacturing environment. Data is protected by 813 
“locking” individual partitions of the HDD using a software utility, permanently preventing the data from 814 
modification and deletion. 815 

2.4.1 Host and Network Configuration 816 

The WORMdisk and ForceField HDDs were installed in a rack-mount server appliance provided by 817 
GreenTec-USA and described in Table 2-8. The overall build architectures utilizing this appliance and 818 
devices are described in Section 4.5 in Volume B.  819 

Table 2-8 GreenTec-USA WORMdrive and ForceField Deployment 820 

Name System OS CPU Memory Storage Network 

GreenTec-
USA 
Server 

Supermicro 
x8 Series 
Server 

Ubuntu 
18.04 

2x Intel 
Xeon 
E5620 

16 GB 750 GB OS 
1.0 TB WORMdisk 
1.0 TB ForceField 

DMZ 
10.100.1.7 

 

2.4.2 Installation 821 

The ForceField and WORMdisk HDDs were hosted on a hardware appliance provided by GreenTec-USA. 822 
The unit was placed within a standard datacenter rack unit and connected to the network as shown in 823 
Figure B-1, Figure B-2, Figure B-3, and Figure B-4.  824 

Full documentation and installation guides are provided to customers by GreenTec-USA.  825 

NIST chose to utilize Samba as the network file sharing protocol due to the prevalence of Windows and 826 
Linux workstations within the testbed. The GreenTec-USA appliance did not come with Samba pre-827 
installed, so installation was performed via the Ubuntu Advanced Packaging Tool and the Ubuntu 828 
package repository.  829 

NOTE: GreenTec-USA typically provides turnkey server storage solutions. Installation and configuration 830 
of file sharing packages and other software will likely not be required.  831 

NOTE: Many of the commands used to manage the ForceField and WORMdisk HDDs must be executed 832 
by a user with superuser privileges or as the root user.  833 

1. Add the default gateway so the appliance can communicate to other devices on the network 834 
using the following command: 835 

$ sudo route add default gw 10.100.1.1 836 
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2. In a terminal window on the GreenTec-USA appliance, execute these commands: 837 

$ sudo apt update 838 
$ sudo apt -y install samba 839 
$ sudo ufw allow samba 840 

2.4.3 Configuration 841 

The appliance provided by GreenTec-USA for this project was preconfigured with the ForceField HDD as 842 
device /dev/sdc and the WORMdisk HDD as device /dev/sdb.  843 

2.4.3.1 ForceField HDD 844 

The ForceField HDD is configured as a mounted volume, allowing the drive to be used as a typical HDD 845 
by using native operating system commands.  846 

1. Create a mount point (empty directory) for the ForceField HDD using the following command: 847 

$ sudo mkdir /mnt/forcefield 848 

2. Start the ForceField WFS volume manager to mount the drive using the following command: 849 

$ sudo /opt/greentec/forcefield/bin/wfs /dev/sdc /mnt/forcefield/ 850 

2.4.3.2 WORMdisk HDD 851 

The WORMdisk is divided into 120 partitions to enable periodic updates and revisions to the protected 852 
data (i.e., data in the “golden” directory). Once a partition is locked it cannot be modified, so the next 853 
sequential partition on the drive is used as the new “golden” directory.  854 

1. Format the WORMdisk with 120 partitions (NOTE: this operation must be performed from the 855 
command line as administrator on a computer with the Microsoft Windows OS) using the 856 
following command: 857 

> gt_format.exe 1 /parts:120 858 

2. In the Ubuntu OS, create the mountpoint for the WORMdisk HDD partition using the following 859 
command: 860 

$ sudo mkdir /mnt/golden 861 

3. Add a persistent mount to the /etc/fstab file: 862 

$ sudo echo “/dev/sdb2 /mnt/golden fuseblk 863 
rw,nosuid,nodev,relatime,user_id=0,group_id=0,allow_other,blksize864 
=4096 0 0” >> /etc/fstab 865 

4. Create a directory structure within the “golden” directory and copy approved files into those 866 
directories (e.g., PLC logic, device firmware, approved software).  867 

5. Once all files have been copied and verified, lock the partition to protect the data: 868 

$ sudo /greentec/Ubuntu/wvenf /dev/sdb2 869 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 34 

When it is time to create a new “golden” partition, the partition names in the /etc/fstab file must be 870 
updated to point to the correct partition. The following instructions provide an example process to 871 
update the files and increment the golden partition from /dev/sdb2 to /dev/sdb3.  872 

1. On the GreenTec-USA appliance, create a temporary directory, mount the folder to the next 873 
unlocked WORMdisk partition, and copy existing “golden” files to the temporary directory: 874 

$ sudo mkdir /mnt/tmp 875 
$ sudo mount /dev/sdb3 /mnt/tmp 876 
$ sudo cp -R /mnt/golden /mnt/tmp 877 

2. Update the files and folders in the temporary directory, /mnt/tmp, as desired. 878 

3. Unmount the temporary directory and lock the partition: 879 

$ sudo umount /mnt/tmp 880 
$ sudo /greentec/Ubuntu/wvenf /dev/sdb3 881 

4. Stop the Samba service: 882 

$ sudo systemctl stop smb.service 883 

5. Unmount the golden partition: 884 

$ sudo umount /mnt/golden 885 

6. Modify the /etc/fstab file with the new partition name and save the file: 886 

/dev/sdb3 /mnt/golden fuseblk 887 
rw,nosuid,nodev,relatime,user_id=0,group_id=0,allow_other,blksize888 
=4096 0 0” 889 

7. Re-mount all partitions, start the Samba service, and remove the temporary directory: 890 

$ sudo mount -a 891 
$ sudo systemctl stop smb.service 892 
$ sudo rmdir -r /mnt/tmp  893 

2.4.3.3 Samba 894 

1. Add local user accounts to the appliance for accessing the network file shares and create a 895 
password:  896 

$ sudo adduser nccoeuser 897 
$ sudo smbpasswd -a nccoeuser 898 

2. Open the file /etc/samba/smb.conf and add the following content to the end of the 899 
file to create the individual shares: 900 

# GreenTec-USA ForceField Share 
strict sync=no 

 
# OSIsoft PI historian and database backups 

[ForceField] 
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  browsable = yes 
  guest ok = no 
  path = /mnt/forcefield 
  read only = no 
  writeable = yes 
  case sensitive = yes 
  
# GreenTec-USA Golden WORMDisk Share 
[golden] 
  browsable = yes 
  guest ok = no 
  path = /mnt/golden 
  read only = no 
  writeable = yes 
  case sensitive = yes 
 

3. Restart Samba: 901 

$ sudo systemctl restart smbd.service 902 

2.4.3.4 OSIsoft PI Server and Database Backups 903 

Create the scheduled backup task to backup PI Data Archive files. The script automatically inserts the 904 
current datetime stamp into the filename of each file copied to the ForceField drive. Follow these steps: 905 

1. On the server containing the PI Data Archive, open a command prompt with Administrator 906 
privileges.  907 

2. Change to the PI\adm directory: 908 

> cd /d “%piserver%adm” 909 

3. Create the backup directory, and start the Windows scheduled task to perform the backup: 910 

> pibackup h:\PIBackup -install 911 

Create a scheduled task to copy the backup files to the ForceField HDD. Follow these steps: 912 

1. Open the Task Scheduler and create a new scheduled task to rename, timestamp, and copy the 913 
backup files to the ForceField HDD: 914 

Trigger: At 3:30 AM every day 915 

Action: Start a Program 916 

Program/script: 917 
C:\Windows\System32\WindowsPowerShell\v1.0\powershell.exe 918 

Add arguments (optional): -Command { Get-ChildItem -Path 919 
"h:\PIBackup\arc\" | foreach { copy-item -path $($_.FullName) -920 
destination "\\10.100.1.7\ForceField\$(Get-Date -f yyyy-MM-921 
dd_HHMMss)_$($_.name)" } } 922 
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2.5 Microsoft Azure Defender for IoT 923 

Microsoft Azure Defender for IoT, based on technology acquired via CyberX, consists of a single 924 
appliance containing the sensor and application interface integrated into Build 4 to meet BAD, hardware 925 
modification, firmware modification, and software modification capabilities. The Microsoft Azure 926 
Defender for IoT implementation utilizes passive monitoring and protocol analysis to support 927 
cybersecurity monitoring and threat detection. 928 

2.5.1 Host and Network Configuration 929 

Microsoft Azure Defender for IoT was installed and configured to support the CRS environment as part 930 
of Build 4. The overall build architecture is provided in Figure B-4. The Microsoft Azure Defender for IoT 931 
specific components are in Table 2-9. 932 

Table 2-9 Microsoft Azure Defender IoT Deployment 933 

Name System OS CPU Memory Storage Network 

Azure Defender 
for IoT 

Dell OEMR 
XL R340 

Ubuntu 18.04 Intel 
Xeon E-
2144G 

32 GB 3x 2 TB 
Drives 
RAID-5 

Testbed LAN 
10.100.0.61 

 

2.5.2 Installation 934 

The Microsoft Azure Defender for IoT (Version 10.0.3) appliance was preinstalled with the operating 935 
system and application. The appliance is mounted in a rack with power and network interfaces 936 
connected to the Testbed LAN on the Eth0 port along with the SPAN connection on the expansion 937 
network interface board. 938 

2.5.3 Configuration 939 

To configure the Microsoft Azure Defender for IoT platform, follow these steps: 940 

1. Set the Network Configuration: 941 

a. Using either SSH, iDRAC, or the KVM Console connections on the appliance, establish 942 
shell access to the appliance. 943 

b. From the console, enter the following command: 944 

$sudo cyberx-xsense-network-reconfigure 945 

c. The system will walk through a series of network options (Figure 2-25) that are set as 946 
follows: 947 

i. IP Address: "10.100.0.61" 948 

ii. Subnet Mask: "255.255.255.0" 949 

iii. DNS: "10.100.0.17" 950 
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iv. Default Gateway: "10.100.0.1" 951 

v. Hostname: Not set 952 

vi. Input Interface(s): "enp3s0f3, enp1s0f2, enp3s0f1, enp1s0f0, enp1s0f3, enp3s0f2, 953 
enp1s0f1, enp3s0f0" 954 

vii. Bridge Interface(s): Not Set 955 

Figure 2-25 Azure Defender for IoT SSH Session for Network Configuration 956 

 

2. Create AMS Protocol report as a data mining tool: 957 

a. Login to the application web interface and click Data Mining in the left menu navigation. 958 

b. Click the + sign and click New Report. In the Create New Report panel set the following 959 
settings (Figure 2-26): 960 

i. Under Categories select AMS to automatically select the sub-elements, including: 961 

1) AMS Firmware Information 962 

2) AMS Index Group 963 

3) AMS Index Group Offset 964 
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4) AMS Protocol Command 965 

ii. Enter "AMS Data Analysis" as the name for the report. 966 

iii. Click Save. 967 

Figure 2-26 Azure Defender for IoT Create New Data Mining Report for AMS Protocol Information 968 

 

3. Create AMS – Custom Alert Rules 969 

For this effort, the CRS PLC is configured to run using firmware version 3.1.4022 as the approved 970 
production firmware version. To detect changes to the approved version, custom alert rules are 971 
created to monitor for deviations from the approved version numbers through the AMS protocol 972 
messages over the network. 973 

a. Click Horizon on the left menu navigation. 974 

b. Select AMS > Horizon Customer Alert under the Plugin Options on the left menu. 975 

c. Create Custom Alert to Detect Change in PLC Firmware Major Build Number (Figure 976 
2-27): 977 

i. Enter "PLC Firmware Major Build Mismatch" as the title for the custom alert.  978 

ii. Enter "PLC {AMS_server_ip} Firmware Major Version Build Mismatch Detected" 979 
as the message to display with the alert.  980 

iii. Set the following conditions: 981 
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1) AMS_server_ip == 3232235550 (Note: this is the PLC IP address 982 
192.168.0.30 in Integer format). 983 

2) AND AMS_major ~= 3 984 

Figure 2-27 Azure Defender for IoT Custom Alert for Firmware Major Version Number Change 985 

 

d. Create the custom alert to detect change in PLC firmware minor build number (Figure 986 
2-28): 987 

i. Enter "PLC Firmware Minor Build Mismatch" as the title for the custom alert. PLC 988 
Firmware Minor Build Mismatch 989 

ii. Enter "PLC {AMS_server_ip} Firmware Minor Version Build Mismatch Detected" 990 
as the message to display with the alert.  991 

iii. Set the following conditions: 992 

1) AMS_server_ip == 3232235550 (Note: this is the PLC IP address 993 
192.168.0.30 in Integer format). 994 

2) AND AMS_minor ~= 1 995 
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Figure 2-28 Azure Defender for IoT Custom Alert for Firmware Minor Version Number Change 996 

 997 

e. Create the custom alert to detect change in the PLC Firmware Build Version (Figure 998 
2-29): 999 

i. Enter "PLC Firmware Build Version Mismatch" as the Title for the custom alert.  1000 

ii. Enter "PLC {AMS_server_ip} Build Version Mismatch Detected" as the message to 1001 
display with the alert:  1002 

iii. Set the following conditions: 1003 

1) AMS_server_ip == 3232235550 (Note: this is the PLC IP address 1004 
192.168.0.30 in Integer format). 1005 

2) AND AMS_version_build ~= 4022 1006 

Figure 2-29 Azure Defender for IoT Custom Alert for Firmware Build Version Number Change 1007 

 1008 
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2.6 OSIsoft PI Data Archive 1009 

The OSIsoft product included in this practice guide is Process Information (PI), which is used to collect, 1010 
store, analyze, and visualize testbed data. The product was utilized in Builds 1, 2, 3, and 4 to meet the 1011 
Historian capability by collecting and storing testbed data and the BAD capability by alerting when 1012 
activity deviates from a baseline. 1013 

OSIsoft PI is a suite of software applications for capturing, analyzing, and storing real-time data for 1014 
industrial processes. Although the PI System is typically utilized as a process historian, the PI System is 1015 
also utilized to collect, store, and manage data in real time. Interface nodes retrieve data from disparate 1016 
sources to the PI Server, where the PI Data Archive resides. Data is stored in the data archive and is 1017 
accessible in the assets defined in the Asset Framework (AF). Data is accessed either directly from the 1018 
data archive or from the AF Server by using tools in the PI visualization suite.  1019 

2.6.1 Host and Network Configuration 1020 

PI was installed on virtual machines hosted on hypervisors located in the DMZ and CRS networks. The 1021 
virtual machine details and resources are provided in Table 2-10, Table 2-11 and, Table 2-12. The overall 1022 
build architectures utilizing PI are described in Section 4.5 in Volume B.  1023 

Table 2-10 OSIsoft PI Domain Hosts Deployment 1024 

Name System OS CPU Memory Storage Network 

 
DMZ Histo-
rian 

Virtual 
Machine 

Microsoft Windows 
Server 2016 

4x Intel Xeon 
E3-1240 

8 GB Boot: 
80 GB 
PI Data: 
170 GB 

DMZ 
10.100.1.4 

 1025 

Table 2-11 OSIsoft PI CRS Hosts Deployment 1026 

Name System OS CPU Memory Storage Network 

CRS Local 
Historian 

Virtual 
Machine 

Microsoft Windows 
Server 2016 

4x Intel Xeon 
E5-2407 

16 GB Boot: 
80 GB 
PI Data: 
170 GB 

CRS Supervi-
sory LAN 
192.168.0.21 

 1027 

Table 2-12 OSIsoft PI PCS Hosts Deployment 1028 

Name System OS CPU Memory Storage Network 

PCS Local 
Historian 

Virtual 
Machine 

Microsoft Windows 
Server 2008 R2 

1x Intel i5-
4590 

2 GB 50 GB PCS VLAN 2 
172.16.2.14 

 1029 
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2.6.2 Installation 1030 

PI was previously installed in the testbed as part of the NISTIR 8219: Securing Manufacturing Industrial 1031 
Control Systems: Behavioral Anomaly Detection, 1032 
https://www.nccoe.nist.gov/sites/default/files/library/mf-ics-nistir-8219.pdf. The installation for this 1033 
project involved upgrading the existing CRS Local Historian and DMZ Historian VMs to Microsoft 1034 
Windows Server 2016, and subsequently upgrading all the PI software components. Step-by-step 1035 
instructions for each PI component installation are not included for brevity. Detailed instructions 1036 
provided by the vendor can be found on the OSIsoft Live Library: https://livelibrary.osisoft.com/.  1037 

DMZ Historian Server 1038 

The following software is installed on the DMZ Historian server:  1039 

 Microsoft SQL Server 2019 Express 15.0.2080.9 1040 

 PI Server 2018 (Data Archive Server, Asset Framework Server) 1041 

 PI Server 2018 SP3 Patch 1 1042 

 PI Interface Configuration Utility version 1.5.1.10 1043 

 PI to PI Interface version 3.10.1.10 1044 

 PI Interface for Ramp Soak Simulator Data 3.5.1.12 1045 

 PI Interface for Random Simulator Data 3.5.1.10 1046 

 PI Connector Relay version 2.6.0.0 1047 

 PI Data Collection Manager version 2.6.0.0 1048 

 PI Web API 2019 SP1 version 1.13.0.6518 1049 

CRS Local Historian Server (Collaborative Robotics System) 1050 

The following software is installed on the CRS Local Historian server: 1051 

 Microsoft SQL Server 2019 Express 15.0.2080.9 1052 

 PI Asset Framework Service 2017 R2 Update 1  1053 

 PI Data Archive 2017 R2A 1054 

 PI Server 2018 SP3 Patch 1 1055 

 PI Interface Configuration Utility version 1.5.1.10 1056 

 PI to PI Interface version 3.10.1.10 1057 

 PI Interface for Ramp Soak Simulator Data 3.5.1.12 1058 

 PI Interface for Random Simulator Data version 3.5.1.10 1059 

 PI Interface for Performance Monitor version 2.2.0.38 1060 

 PI Ping Interface version 2.1.2.49 1061 

 PI Interface for Modbus ReadWrite version 4.3.1.24 1062 

 PI Interface for SNMP ReadOnly version 1.7.0.37 1063 

https://www.nccoe.nist.gov/sites/default/files/library/mf-ics-nistir-8219.pdf
https://livelibrary.osisoft.com/
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 PI TCP Response Interface version 1.3.0.47 1064 

 PI Processbook 2015 R3 Patch 1 version 3.7.1.249 1065 

 PI Vision 2019 Patch 1 version 3.4.1.10 1066 

 PI System Connector version 2.2.0.1 1067 

PCS Local Historian (Process Control System Historian) 1068 

 Rockwell FactoryTalk Historian SE version 1.00 1069 

2.6.3 Configuration 1070 

The following sections describe how to configure select PI components to enable the capabilities 1071 
described in this guide. Configurations for the other PI components are not included for brevity.  1072 

2.6.3.1 PI to PI Interface (PCS) 1073 

The PCS uses the Rockwell FactoryTalk Historian to collect, store, and analyze historical process data. 1074 
The PI to PI Interface is used to duplicate the process data to the DMZ Historian server. The following 1075 
steps describe how to configure the PI to PI Interface to collect data from the Rockwell FactoryTalk 1076 
Historian.  1077 

1. On the DMZ Historian server, launch the PI Interface Configuration Utility as shown in Figure 1078 
2-30 from the Start menu and sign in with the local administrator account. 1079 
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Figure 2-30 Screenshot of the PI Interface Configuration Utility before the Interface is configured. 1080 

 1081 

 1082 

2. On the top menu, click Interface > New Windows Interface Instance from BAT File… 1083 

3. Navigate to E:\Program Files (x86)\PIPC\Interfaces\PItoPI and select the file PItoPI.bat_new. 1084 

4. In the “Select Host PI Data server/collective” dialog box, select PI-DMZ from the drop-down 1085 
menu and click OK.  1086 

5. In the left navigation panel select PItoPI. In the Source host textbox, enter "172.16.2.4".  1087 

6. In the left navigation panel, select Service. In the “Create / Remove” section click the Create 1088 
button. Click Yes in the dialog box.  1089 

7. Enter the commands net start PItoPI and net stop PItoPI in the files 1090 
pisrvsitestart.bat and pisrvsitestop.bat files, respectively. Save and close the files. 1091 

8. At the bottom of the PI Interface Configuration Utility click the Apply button. On top menu bar 1092 

click the green play button  to start the service.  1093 
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9. Close the PI Interface Configuration Utility. The interface is now configured to pull tags from the 1094 
Rockwell Historian.  1095 

2.6.3.2 PI System Connector (CRS) 1096 

The PI System Connector is used to duplicate process data on the DMZ Historian from the CRS Local 1097 
Historian server. The following steps describe how to configure the PI-to-PI Interface to collect data 1098 
from the OSIsoft PI Server. 1099 

Figure 2-31 Screenshot of the PI Data Collection Manager Displaying Green Checkmarks After the PI 1100 
System Connector is Properly Configured  1101 

 1102 

1. On the DMZ Historian server, launch the PI Data Collection Manager as shown in Figure 2-31 1103 
from the Start menu and sign in with the local administrator account. 1104 

a. Click + on the Relays column to add a new connector relay. Use the following settings: 1105 

b. Name: PI-DMZ-Relay 1106 

c. Address: 10.100.1.4 1107 

d. Port: 5460 1108 

2. User Name: .\piconnrelay_svc 1109 

3. Click Save Settings to add the connector relay.  1110 

4. Click + Add Destination to add the target PI Data Archive and PI AF Server. Use the following 1111 
settings: 1112 

a. Name: 10.100.1.4 1113 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 46 

b. PI Data Archive Address: 10.100.1.4 1114 

c. AF Server: 10.100.1.4 1115 

5. Click Save Settings to add the destination.  1116 

6. On the CRS Local Historian server, open the PI System Connector Administration from the Start 1117 
menu and sign in with the local administrator account.  1118 

7. Click Set up Connector to create a new connector. 1119 

8. Use the following information to request registration: 1120 

a. Registration Server Address: https://PI-DMZ:5460 1121 

b. Registration Server User Name: piconnrelay_svc 1122 

c. Registration Server Password:  1123 

d. Description: Registration to PI-DMZ 1124 

9. Click Request Registration to send the request to the DMZ Historian server.  1125 

10. On the DMZ Historian server, open the PI Data Collection Manager from the Start menu and 1126 
sign in with the local administrator account. 1127 

11. Click Untitled Connector 1 and click Approve This Registration and Configure to approve the PI 1128 
System Connector registration.  1129 

12. In the Untitled Connector 1 details panel, click Edit.  1130 

13. Use the following information to create the CRS-Connector connector: 1131 

a. Name: CRS-Connector 1132 

b. Description: Registration to PI-DMZ 1133 

14. Click Save Settings to create the CRS-Connector.  1134 

15. Click CRS-Connector in the Connectors column. On the Overview panel click CRS-Connector: No 1135 
Data Sources option to create the data source.  1136 

16. On the CRS-Connector Connector Details in the Overview panel, click + Add Data Source. 1137 

17. In the Data Source Settings window, use the following settings: 1138 

a. Name: CRS-DS 1139 

b. Source AF Server: PI-Robotics 1140 

c. Source AD Database: TestbedDatabase 1141 

d. Select Collect All Data from this Entire Database. 1142 

18. Click Save to save the data source.  1143 

https://pi-dmz:5460/
https://pi-dmz:5460/
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19. Click 10.100.1.4 in the Destination column of the Routing panel and then click Data in the 1144 
10.100.1.4 Destination Details panel to configure the destination database for the CRS-1145 
Connector. 1146 

20. In the 10.100.1.4 Destination Details panel, change from Change Default Settings for new 1147 
connectors to "CRS-Connector" and then click Edit Destination Data Settings.  1148 

21. In the 10.100.1.4 Destination Details of the Overview panel, use the following settings: 1149 

a. Change the connector to CRS-Connector. 1150 

b. Database: CRS-backup 1151 

c. Click on Elements and it will change <select a path using the tree below> to $Elements\ 1152 

d. Use default settings in Root AF Elements and Point Names. 1153 

e. Create root Element CRS-Connector checkbox: Checked 1154 

f. Prefix Point CRS-Connector checkbox: Checked 1155 

22. Click Save Destination Data Settings to save the configuration. 1156 

23. Click the white space in the Routing panel.  1157 

24. Click CRS-Connector: No Relays in the Overview panel.  1158 

25. Select the PI-DMZ-Relay checkbox in the Routing panel. 1159 

26. Click the white space in the Routing panel again, then Click PI-DMZ-Relay: No Destination to 1160 
add the routing between relays and destinations.  1161 

27. Select the 10.100.1.4 checkbox to add the routing between the relay and the destination.  1162 

28. Click Save Configuration.  1163 

29. In the Save Routing and Data Configuration window, select Save and Start All Components to 1164 
continue. 1165 

30. Each box should now contain a green checkmark (i.e., Data Sources, Connectors, Relays, and 1166 
Destinations). The elements in the AF database “testbeddatabase” on CRS Local Historian server 1167 
is now replicated to AF database “CRS-backup” on the DMZ Historian server.  1168 

31. Finally, create a Windows firewall rule to open the inbound ports 5460, 5461, 5471, and 5472.  1169 

2.6.3.3 PI Asset Template Analysis Functions and Event Frames 1170 

Analysis functions and event frame templates were created to generate alerts in the PLC asset template 1171 
when their respective anomalous events are detected. When an analysis function result is TRUE, an 1172 
event frame is generated from the event frame template and ends when the analysis function result is 1173 
FALSE or per a user-defined function. The following steps describe how the “Station Mode Error” 1174 
analysis function and event frame template were created and used in Scenario 10.  1175 
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1. On the CRS Local Historian server, open the PI System Explorer by navigating to Start Menu > PI 1176 
System > PI System Explorer. 1177 

2. On the left navigation panel, select Library.  1178 

3. In the navigation tree in the Library panel, select Templates > Event Frame Templates.  1179 

4. Right click in the whitespace of the Element Templates window and select New Template. 1180 

a. Enter the following: 1181 

b. Name: Station Mode Error 1182 

c. Description: CRS Workcell machining station mode error 1183 

5. Naming Pattern: ALARM-%ELEMENT%.%TEMPLATE%.%STARTTIME:yyyy-MM-dd 1184 
HH:mm:ss.fff% 1185 

6. In the navigation tree in the Library panel, select Templates > Element Templates > 1186 
Machining_Station. 1187 

7. In the Machining_Station panel select the Analysis Templates tab and click Create a new 1188 
analysis template.  1189 

8. Enter the name “Station Mode Error” in the Name textbox, enter a description of the analysis in 1190 
the Description textbox, and select the option “Event Frame Generation” for the Analysis Type.  1191 

9. Select “Station Mode Error” in the Event Frame template drop-down menu.  1192 

10. In the Expression field for “StartTrigger1”, enter the expression:  1193 

'RawMode' < 0 OR 'RawMode' > 1; 1194 

11. Click the Add… drop-down menu and select End Trigger, and enter the expression: 1195 

('RawMode' > 0 AND 'RawMode' < 1) 1196 

12. Select the “Event-Triggered” option for the Scheduling type. 1197 

13. Click the Check In button on the top menu to save all changes to the database.  1198 

2.6.3.4 PI Web API 1199 

The PI Web API is used by Dragos to collect event frames from the DMZ Historian server. After 1200 
completing the installation of the PI Web API, the “Change PI Web API Installation Configuration” dialog 1201 
displays. The following steps describe how to configure the Web API on the DMZ Historian server.  1202 

1. In the Telemetry section, verify the checkbox option and click Next. 1203 

2. In the Configuration Store section, select "PI-ROBOTICS" in the Asset Server drop-down menu 1204 
and click Connect. Leave the default instance name.  1205 

3. In the Listen Port section, verify port 443 is entered in the Communication Port Number 1206 
textbox and check the Yes, please create a firewall Exception for PI Web API checkbox. 1207 
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4. In the Certificate section, click Next to continue and use the self-signed certificate or select 1208 
Change to modify the certificate.  1209 

5. In the API Service section, leave the default service NT Service\piwebapi and click Next. 1210 

6. In the Crawler Service section, leave the default service NT Service\picrawler and 1211 
click Next. 1212 

7. In the Submit URL section, enter the URL of the DMZ Historian server Web API service: 1213 
https://pi-dmz/piwebapi/. Click Next. 1214 

8. In the Review Changes section, verify all the configuration settings, check the checkbox Accept 1215 
all the configurations, and click Next.  1216 

9. Click Finish to complete the configuration.  1217 

2.6.3.5 Firmware Integrity Checking 1218 

Software was developed to demonstrate the ability of PI to obtain device and firmware data from a 1219 
Beckhoff PLC for integrity checking purposes. A new PLC task was programmed to periodically query its 1220 
operating system for hardware and software telemetry and make it available via Modbus TCP. PI will 1221 
query these Modbus registers and use analysis functions to generate event frames if any tags do not 1222 
match their expected values.  1223 

It is important to note that this capability was developed to demonstrate a method of maintaining 1224 
visibility of PLC hardware and firmware version numbers for integrity purposes and is not secure or 1225 
infallible. If a malicious actor takes control of the PLC, the hardware and firmware versions provided by 1226 
the PLC can be spoofed.  1227 

The following steps describe how to sequentially configure this capability across multiple systems and 1228 
software. Only one system or software is described in each section.  1229 

Beckhoff PLC Modbus TCP Server 1230 

The base Modbus TCP server configuration file only allows one PLC task to write to the registers. The 1231 
following steps describe how to modify the configuration to allow two PLC tasks to write to the Modbus 1232 
TCP server input registers.  1233 

1. Log in to the Windows CE Desktop of the Beckhoff PLC and open the XML file: 1234 
\TwinCAT\Functions\TF6250-Modbus-TCP\Server\TcModbusSrv.xml 1235 

2. Modify the <InputRegisters> … </InputRegisters> section to the following: 1236 

https://pi-dmz/piwebapi/
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<InputRegisters> 
 <MappingInfo> 
    <AdsPort>851</AdsPort> 
    <StartAddress>32768</StartAddress> 
    <EndAddress>32895</EndAddress> 
    <VarName>GVL.mb_Input_Registers</VarName> 
  </MappingInfo> 
  <MappingInfo> 
    <AdsPort>852</AdsPort> 
    <StartAddress>32896</StartAddress> 
    <EndAddress>33023</EndAddress> 
    <VarName>GVL.mb_Input_Registers</VarName> 
  </MappingInfo> 
</InputRegisters> 

 1237 

3. Save and close the file.  1238 

4. Restart the PLC.  1239 

The Modbus TCP server will now have two register address ranges: 128 addresses for the PLC task at 1240 
port 851, and 128 addresses for the PLC task at port 852.  1241 

Beckhoff PLC Project 1242 

A new PLC task must be created to perform the integrity checking and write the data to the Modbus TCP 1243 
registers. The following steps describe how to create and configure the new task.  1244 

1. On the engineering workstation, open the TwinCAT XAE Shell by navigating to Start Menu > 1245 
Beckhoff > TwinCAT XAE Shell and open the current PLC project. 1246 

2. In the Solution Explorer, right click PLC and select Add New Item… 1247 

3. In the Add New Item dialog box, select Standard PLC Project, enter the name 1248 
FirmwareIntegrityCheck in the Name textbox, and click Add.  1249 

4. In the Solution Explorer, double click SYSTEM > Tasks > PLCTask1. Verify the Auto Start 1250 
checkbox is checked and change the Cycle Ticks textbox to 100 ms.  1251 

5. In the Solution Explorer, right click PLC > FirmwareIntegrityCheck > References and click Add 1252 
library… In the dialog box, select the library System > Tc2_System and click OK.  1253 

6. In the Solution Explorer, right click PLC > GVLs and click Add > Global Variable List. In the dialog 1254 
box enter the name GVL in the Name textbox and click Open. 1255 

7. In the Editor Window, enter the following code: 1256 

VAR_GLOBAL 
    mb_Input_Registers : ARRAY [0..127] OF WORD; 
END_VAR 

 1257 
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8. In the Solution Explorer, right click PLC > FirmwareIntegrityCheck > POU and select Add > POU. 1258 
In the Add POU dialog box, enter the name GetSystemInfo, select the type Function Block, 1259 
select the Implementation Language Structured Text (ST)and click Open.  1260 

9. In the Editor Window, enter the following code in the Variables section: 1261 

// Gathers PLC information for system integrity checking 
// (e.g., PLC serial number, TwinCAT version). 
FUNCTION_BLOCK GetSystemInfo 
VAR_INPUT 
 NetId : T_AmsNetId; // AMS network ID of the PLC 
END_VAR 
VAR_OUTPUT 
 HardwareSerialNo : WORD; // Serial number of PLC 
 TwinCATVersion : WORD; // Version number of TwinCAT 
 TwinCATRevision : WORD; // Revision number of 
TwinCAT 
 TwinCATBuild : WORD; // Build number of TwinCAT 
END_VAR 
VAR 
 DeviceData : FB_GetDeviceIdentification; //PLC data 
struct 
 Timer : TON; // Timer to trigger the scan 
 Period : TIME := T#5M; // Amount of time between 
each scan  
 State : INT := 0; // Function block state 
END_VAR 

 1262 

10. In the Editor Window, enter the following code in the Code section: 1263 
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CASE state OF  
 0:  
  // Start a new request for device 
identification 
  DeviceData(bExecute:=TRUE, tTimeout:=T#100MS, 
sNetId:=NetId); 
  // Switch to the next state once the request 
completes 
  IF DeviceData.bBusy = FALSE THEN 
   state := 10;  
  END_IF 
 10:  
  // Store the interesting data into our internal 
variables 
  HardwareSerialNo := 
STRING_TO_WORD(DeviceData.stDevIdent.strHardwareSerialNo); 
  TwinCATVersion   := 
STRING_TO_WORD(DeviceData.stDevIdent.strTwinCATVersion); 
  TwinCATRevision  := 
STRING_TO_WORD(DeviceData.stDevIdent.strTwinCATRevision); 
  TwinCATBuild     := 
STRING_TO_WORD(DeviceData.stDevIdent.strTwinCATBuild); 
  // Reset the timer and move to the next state 
  Timer(IN:= FALSE); 
  state := 20; 
 20: 
  // Make sure the timer is running and change to 
the 
           // next state once the period has been reached 
  Timer(IN:=TRUE,PT:=Period); 
  IF Timer.Q = TRUE THEN 
   state := 0; 
  END_IF 
END_CASE 

 1264 

11. Save and close the POU. 1265 

12. In the Solution Explorer, double click PLC > FirmwareIntegrityCheck > POUs > MAIN (PRG).  1266 

13. In the Editor Window, enter the following into the Variables section (your AMS net ID may 1267 
differ from what is shown below): 1268 

PROGRAM MAIN 
VAR 
 PLCInfo : GetSystemInfo; // Periodically collects 
PLC data 
 SelfNetId : T_AmsNetId := '5.23.219.8.1.1'; // Local 
address 
END_VAR 

 1269 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 53 

14. In the Editor Window, enter the following into the Code section: 1270 

// Captures hardware serial numbers and TwinCAT version  
// numbers from the PLC and shares them with other  
// devices via Modbus TCP. 
PLCInfo( NetId:=SelfNetId, 
     HardwareSerialNo => GVL.mb_Input_Registers[0], 
           TwinCATVersion   => GVL.mb_Input_Registers[1], 
           TwinCATRevision  => GVL.mb_Input_Registers[2], 
           TwinCATBuild     => GVL.mb_Input_Registers[3] 
         ); 

 1271 

15. Save and close the POU.  1272 

16. In the top menu, select Build > Build Project. Once the build process completes select PLC > 1273 
Login. In the TwinCAT PLC Control dialog box, select Login with download, verify the Update 1274 
boot project checkbox is checked, and click OK. If the PLC code is not running after the 1275 
download completes, select PLC > Start in the top menu.  1276 

17. The firmware integrity checking code is now running on the Beckhoff PLC. In the top menu 1277 
select PLC > Logout and close the TwinCAT XAE Shell.  1278 

The PLC will now write the hardware serial number and firmware version numbers to the Modbus 1279 
TCP server registers.  1280 

OSIsoft PI Points 1281 

The following steps describe how to create the PI points and tags in the CRS Local Historian server and 1282 
duplicate the tags to the DMZ Historian server.  1283 

1. On the CRS Local Historian server, open the PI Interface Configuration Utility by navigating to 1284 
Start > All Programs > PI System > PI Interface Configuration Utility.  1285 

2. In the Interface drop-down menu, select the Modbus Interface (PIModbusE1). 1286 

3. Select the General menu option. In the Scan Classes section, click the New Scan Class button. 1287 

4. Set the Scan Frequency to "60" and the Scan Class # to the next sequential class number as 1288 
shown in Figure 2-32 below.  1289 
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Figure 2-32 Screenshot of the PI Interface Configuration Utility Showing the Added Scan Class # 2 for 1290 
Polling the PLC Every 60 Seconds  1291 

 1292 

 1293 

5. Click Apply and close the program. 1294 

6. On the CRS Local Historian server, open the PI System Management Tools by navigating to Start 1295 
Menu > PI System > PI System Management Tools. 1296 

7. In the System Management Tool panel, select Points > Point Builder. 1297 

8. Create a new tag for the PLC hardware serial number with the following configuration: 1298 

a. Name: PLC-HardwareSerialNumber 1299 

b. Server: PI-ROBOTICS 1300 

c. Descriptor: Hardware serial number of the CRS Beckhoff PLC 1301 

d. Point Source: MODBUSE 1302 

e. Point Type: Int16 1303 
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f. Location 1: 1 1304 

g. Location 2: 0 1305 

h. Location 3: 104 1306 

i. Location 4: 2 1307 

j. Location 5: 32897 1308 

k. Instrument Tag: 192.168.0.30 1309 

9. Create a new tag for the PLC TwinCAT build number with the following configuration: 1310 

a. Name: PLC-TwinCATBuildNumber 1311 

b. Server: PI-ROBOTICS 1312 

c. Descriptor: Build number of the CRS PLC TwinCAT firmware. 1313 

d. Point Source: MODBUSE 1314 

e. Point Type: Int16 1315 

f. Location 1: 1 1316 

g. Location 2: 0 1317 

h. Location 3: 104 1318 

i. Location 4: 2 1319 

j. Location 5: 32900 1320 

k. Instrument Tag: 192.168.0.30 1321 

10. Create a new tag for the PLC TwinCAT revision number with the following configuration: 1322 

a. Name: PLC-TwinCATRevisionNumber 1323 

b. Server: PI-ROBOTICS 1324 

c. Descriptor: Revision number of the CRS PLC TwinCAT firmware. 1325 

d. Point Source: MODBUSE 1326 

e. Point Type: Int16 1327 

f. Location 1: 1 1328 

g. Location 2: 0 1329 

h. Location 3: 104 1330 

i. Location 4: 2 1331 
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j. Location 5: 32899 1332 

k. Instrument Tag: 192.168.0.30 1333 

11. Create a new tag for the PLC TwinCAT version number with the following configuration as shown 1334 
in Figure 2-33: 1335 

a. Name: PLC-TwinCATVersionNumber 1336 

b. Server: PI-ROBOTICS 1337 

c. Descriptor: Version number of the CRS PLC TwinCAT firmware. 1338 

d. Point Source: MODBUSE 1339 

e. Point Type: Int16 1340 

f. Location 1: 1 1341 

g. Location 2: 0 1342 

h. Location 3: 104 1343 

i. Location 4: 2 1344 

j. Location 5: 32898 1345 

k. Instrument Tag: 192.168.0.30 1346 

12. Close the PI System Management Tools program. The PI points are now available to the DMZ 1347 
Historian server via the PI System Connector.  1348 

Figure 2-33 Screenshot of the PI System Management Tools Component After Configuring the PI Points 1349 
for PLC Hardware and Firmware Version Number Integrity Checking  1350 

 1351 

 1352 
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13. On the DMZ Historian server, open the PI System Explorer by navigating to Start Menu > PI 1353 
System > PI System Explorer. 1354 

14. On the left navigation panel, select Library.  1355 

15. In the navigation tree in the Library panel, select Templates > Element Templates > 1356 
PLCTemplate. 1357 

16. Open the Attribute Templates tab in the PLCTemplate panel.  1358 

17. On the top menu bar, click New Attribute Template and create a new attribute for the PLC 1359 
hardware serial number by entering the following configuration: 1360 

a. Name: HardwareSerialNumber 1361 

b. Description: Hardware serial number of the CRS Beckhoff PLC. 1362 

c. Value Type: Int16 1363 

d. Data Reference: PI Point 1364 

e. Tag: \\PI-ROBOTICS\PLC-HardwareSerialNumber 1365 

18. On the top menu bar click New Attribute Template and create a new attribute for the expected 1366 
hardware serial number by entering the following configuration: 1367 

a. Name: HardwareSerialNumber-Expected 1368 

b. Description: Expected hardware serial number of the CRS Beckhoff 1369 
PLC. 1370 

c. Value Type: V 1371 

d. Data Reference: None 1372 

19. On the top menu bar click New Attribute Template and create a new attribute for the PLC 1373 
TwinCAT build number by entering the following configuration: 1374 

a. Name: TwinCATBuildNumber 1375 

b. Description: Build number of the CRS PLC TwinCAT firmware. 1376 

c. Value Type: Int16 1377 

d. Data Reference: PI Point 1378 

e. Tag: \\PI-ROBOTICS\PLC-TwinCATBuild 1379 

20. On the top menu bar click New Attribute Template and create a new attribute for the PLC 1380 
TwinCAT revision number by entering the following configuration: 1381 

a. Name: TwinCATRevisionNumber 1382 

b. Description: Revision number of the CRS PLC TwinCAT firmware. 1383 

file://PI-ROBOTICS/PLC-HardwareSerialNumber
file://PI-ROBOTICS/PLC-TwinCATBuild
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c. Value Type: Int16 1384 

d. Data Reference: V 1385 

e. Tag: \\PI-ROBOTICS\PLC-TwinCATRevision 1386 

21. On the top menu bar click New Attribute Template and create a new attribute for the PLC 1387 
TwinCAT version number by entering the following configuration: 1388 

a. Name: TwinCATVersionNumber 1389 

b. Description: Version number of the CRS PLC TwinCAT firmware. 1390 

c. Value Type: Int16 1391 

d. Data Reference: PI Point 1392 

e. Tag: \\PI-ROBOTICS\PLC-TwinCATVersion 1393 

22. On the top menu bar click New Attribute Template and create a new attribute for the string 1394 
representation of the version, revision, and build numbers by entering the following 1395 
configuration: 1396 

a. Name: TwinCATVersion 1397 

b. Description: Version number of the CRS PLC TwinCAT firmware. 1398 

c. Value Type: String 1399 

d. Data Reference: String Builder 1400 

e. String: 1401 
'TwinCATVersionNumber';.;'TwinCATRevisionNumber';.;'TwinCAT1402 
BuildNumber'; 1403 

23. On the top menu bar click New Attribute Template and create a new attribute for the PLC 1404 
expected TwinCAT version number by entering the following configuration as shown in Figure 1405 
2-34: 1406 

a. Name: TwinCATVersion-Expected 1407 

b. Description: Expected version number of the CRS PLC TwinCAT 1408 
firmware. 1409 

c. Value Type: String 1410 

d. Data Reference: None 1411 

The PI points are now available as PLC attributes in the Asset Framework on the DMZ Historian server.  1412 

file://PI-ROBOTICS/PLC-TwinCATRevision
file://PI-ROBOTICS/PLC-TwinCATVersion
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Figure 2-34 Screenshot of PI System Explorer Displaying some Attributes of the PLC Element. Attributes 1413 
for the TwinCAT version number are visible in the list.  1414 

 1415 

OSIsoft PI Analyses and Event Frames 1416 

The following steps describe how to create the PI analyses and event frame templates to generate event 1417 
frames when the hardware or firmware version numbers do not match the expected values.  1418 

1. In the navigation tree in the Library panel, select Templates > Event Frame Templates. 1419 

2. On the top menu bar click New Template and enter the following configuration as shown in 1420 
Figure 2-35: 1421 

a. Name: Hardware Serial Number Mismatch 1422 

b. Naming pattern: %ELEMENT% %ANALYSIS% (Expected: 1423 
%@.\Elements[.]|HardwareSerialNumber-Expected%, Detected: 1424 
%@.\Elements[.]|HardwareSerialNumber%) %STARTTIME:yyyy-MM-1425 
dd HH:mm:ss.fff% 1426 
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Figure 2-35 Screenshot of PI System Explorer Displaying the Hardware Serial Number Mismatch Event 1427 
Frame Template.  1428 

 1429 

3. On the top menu bar click New Template and enter the following configuration as shown in 1430 
Figure 2-36: 1431 

a. Name: TwinCAT Version Mismatch 1432 

b. Naming pattern: %ELEMENT% %ANALYSIS% (Expected: 1433 
%@.\Elements[.]|TwinCATVersion-Expected%, Detected: 1434 
%@.\Elements[.]|TwinCATVersion%) %STARTTIME:yyyy-MM-dd 1435 
HH:mm:ss.fff% 1436 
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Figure 2-36 Screenshot of PI System Explorer Displaying the TwinCAT Version Mismatch Event Frame 1437 
Template  1438 

 1439 

 1440 

4. Click the Check In button on the top menu to save all changes to the database. 1441 

5. In the navigation tree in the Library panel, select Templates > Element Templates > 1442 
PLCTemplate. 1443 

6. Open the Analysis Templates tab in the PLCTemplate panel and click Create a new analysis 1444 
template.  1445 

7. Enter the following configuration as shown in Figure 2-37: 1446 

a. Name: Hardware Serial Number Mismatch 1447 

b. Description: The PLC hardware serial number does not match the 1448 
expected serial number. 1449 

c. Analysis Type: Event Frame Generation 1450 

d. Enable analyses when created from template: Checked 1451 

e. Generation Mode: Explicit Trigger 1452 

f. Event Frame Template: Hardware Serial Number Mismatch 1453 

8. In the Expression field for “StartTrigger1”, enter the expression:  1454 
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'HardwareSerialNumber'<>'HardwareSerialNumber-Expected' and NOT 1455 
BadVal('HardwareSerialNumber'); 1456 

9. Click Add… drop-down menu and select End Trigger, and enter the expression: 1457 

'HardwareSerialNumber'='HardwareSerialNumber-Expected'; 1458 

10. Select the “Event-Triggered” option for the Scheduling type and “Any Input” for the Trigger On 1459 
drop-down menu.  1460 

Figure 2-37 Screenshot of PI System Explorer Displaying the Hardware Serial Number Mismatch 1461 
Analysis Template in the PLC Element Template 1462 

 1463 

 1464 

11. To create a new analysis template for TwinCAT firmware version mismatch, click Create a new 1465 
analysis template.  1466 

12. Enter the following configuration as shown in Figure 2-38: 1467 

a. Name: TwinCAT Firmware Version Mismatch 1468 

b. Description: The TwinCAT version installed in the PLC does not 1469 
match the expected version. 1470 

c. Analysis Type: Event Frame Generation 1471 

d. Enable analyses when created from template: Checked 1472 

e. Generation Mode: Explicit Trigger 1473 
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f. Event Frame Template: Hardware Serial Number Mismatch 1474 

13. In the Expression field for “StartTrigger1”, enter the expression:  1475 

not Compare('TwinCATVersion','TwinCATVersion-Expected') and NOT 1476 
BadVal('TwinCATVersion'); 1477 

14. Click the Add… drop-down menu and select End Trigger, and enter the expression: 1478 

Compare('TwinCATVersion','TwinCATVersion-Expected'); 1479 

15. Select the “Event-Triggered” option for the Scheduling type and “Any Input” from the Trigger 1480 
On drop-down menu. 1481 

Figure 2-38 Screenshot of PI System Explorer Displaying the TwinCAT Firmware Version Mismatch 1482 
Analysis Template in the PLC Element Template 1483 

 1484 

 1485 

16. On the top menu bar click Check In , verify the changes in the dialog box and click the Check In 1486 
button. 1487 

17. On the left navigation panel, select Elements.  1488 

18. In the navigation tree in the Elements panel, select CRS-Connector > Workcell 1 > PLC. 1489 

19. Open the Attributes tab in the PLC panel.  1490 

20. Select the attribute HardwareSerialNumber-Expected and enter the expected hardware serial 1491 
number (e.g., 5870) in the Value textbox.  1492 
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21. Select the attribute TwinCATVersion-Expected and enter the expected hardware serial number 1493 
(e.g., 3.1.4022) in the Value textbox. 1494 

22. On the top menu bar and click Check In, verify the changes in the dialog box, and click Check In. 1495 

Event frames will now be generated in the DMZ Historian if the PLC reports a hardware serial number 1496 
that does not match the expected value or if the TwinCAT firmware version number does not match the 1497 
expected value.  1498 

2.7 Security Onion 1499 

Security Onion is a Linux-based, open source security playbook. It includes numerous security tools for 1500 
intrusion detection, log management, incident response, and file integrity monitoring. For this project, 1501 
the tool Wazuh was used in Builds 2 and 4 for file integrity checking. Wazuh works at the host-level to 1502 
detect unusual and unauthorized activity and changes to file and software configurations. Security 1503 
Onion and Wazuh use Elastic Stack components, Elasticsearch, Filebeat, and Kibana to store, search, and 1504 
display alert data.  1505 

Note: Wazuh is a fork of the open source project OSSEC, a host-based intrusion detection system. In 1506 
some places in Wazuh and this document, the term OSSEC will be used in place of Wazuh. 1507 

2.7.1 Host and Network Configuration 1508 

Wazuh is an agent-based software. For this project, an existing Security Onion server was used, and the 1509 
Wazuh agent was installed on multiple endpoints in both the PCS and CRS environments. The tables 1510 
below list the network configuration for the Security Onion server (Table 2-13) and the hosts (Table 2-14 1511 
and Table 2-15) with the installed agent.  1512 

Table 2-13 Security Onion Domain Hosts Deployment 1513 

Name System OS CPU Memory Storage Network 

Security On-
ion Server 

Hyper-V VM Ubuntu 16.04 
LTS 

4 16GB 450GB Testbed LAN 
10.100.0.26 

Nessus VM Hyper-V VM Windows 
2012R2 

2 6GB 65GB Testbed LAN 
10.100.0.25 

Dispel VDI Hyper-V VM Windows 2016 2 8GB 126GB DMZ LAN 
10.100.1.61 

DMZ Histo-
rian 

Hyper-V VM Windows 2016 4 8GB 80GB/171GB DMZ LAN 
10.100.1.4 

 1514 
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Table 2-14 Security Onion PCS Hosts Deployment 1515 

Name System OS CPU Memory Storage Network 

PCS Engineer-
ing Work-
station 

HP Z230 
Tower PC 

Windows 7 4 16GB 465GB PCS LAN 3 
172.16.3.10 

PCS HMI Host Supermicro 
Z97X-Ud5H 
 

Windows 7 4 8GB 600GB PCS LAN 1 
172.16.1.4 

 1516 

Table 2-15 Security Onion CRS Hosts Deployment 1517 

Name System OS CPU Memory Storage Network 

CRS Engi-
neering 
Workstation 

Dell Preci-
sion T5610 
 

Windows 10 8 16GB 465GB CRS Supervi-
sory 
192.168.0.20 

 1518 

2.7.2 Installation 1519 

Security Onion Server version 3.9 and Wazuh Agent version 3.9 were used.  1520 

Installation of Wazuh involves setting up the central server and installing agents on hosts that needed to 1521 
be monitored. 1522 

Security Onion server contains the Wazuh manager and API components as well as the Elastic Stack. The 1523 
Wazuh manager is responsible for collecting and analyzing data from deployed agents. The Elastic Stack 1524 
is used for reading, parsing, indexing, and storing alert data generated by the Wazuh manager. 1525 

The Wazuh agent, which runs on the monitored host, is responsible for collecting system log and 1526 
configuration data and detecting intrusions and anomalies. The collected data is then forwarded to the 1527 
Wazuh manager for further analysis. 1528 

The Security Onion server was already a part of the lab infrastructure prior to this effort. For the server 1529 
component installation process, please follow the guidance from the Security Onion Installation Guide 1530 
for version 3.9 available at https://documentation.wazuh.com/3.9/installation-guide/index.html.  1531 

For information on adding agents to the server, please follow the guidance from the Security Onion 1532 
Installation Guide for version 3.9 available at https://documentation.wazuh.com/3.9/user-1533 
manual/registering/index.html. 1534 

2.7.3 Configuration 1535 

1. Configure Additional Directories or Files for Wazuh Agent File Integrity Monitoring:  1536 

a. Files and directories to be monitored are specified in the ossec.conf file on each host.  1537 

https://documentation.wazuh.com/3.9/installation-guide/index.html
https://documentation.wazuh.com/3.9/user-manual/registering/index.html
https://documentation.wazuh.com/3.9/user-manual/registering/index.html
https://documentation.wazuh.com/3.9/user-manual/registering/index.html
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i. To view or edit this file, click the View tab in the Wazuh Configuration Manager 1538 
on the host machine and select View Config as shown in Figure 2-39. 1539 

Figure 2-39 Wazuh Agent Manager 1540 

 1541 

b. Selecting View Config opens the ossec.conf file in Notepad. Alternatively, the file can be 1542 
opened in Notepad from its location in the "C:\Program Files (x86)\ossec-agent" direc-1543 
tory on the host machine, as shown in Figure 2-40. 1544 

Figure 2-40 ossec.conf File 1545 

 1546 

c. To add files or directories to the default configuration, copy and modify an existing line 1547 
in the ossec.conf file to ensure the proper XML syntax is used.  1548 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 67 

d. Once the changes are made, save the ossec.conf file and restart the Wazuh Agent by 1549 
opening the Configuration Manager, selecting "Manage", and "Restart" as shown in Fig-1550 
ure 2-41.  1551 

Figure 2-41 Wazuh Agent Manager User Interface 1552 

 1553 

e. Changes to the files or directories specified in the ossec.conf file will be detected and 1554 
sent to the Wazuh Manager. Figure 2-42 shows the log received after a file change was 1555 
detected. 1556 

Figure 2-42 Log Received After a File Change Was Detected 1557 

 1558 
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2.8 TDi ConsoleWorks 1559 

The TDi ConsoleWorks implementation in Builds 1 and 3 consists of a single VM hosted on VMWare ESXi 1560 
to meet the user authentication and authorization capabilities. ConsoleWorks provides a secure web 1561 
interface through which authenticated and authorized users receive access to graphical and shell 1562 
interfaces on configured ICS components. 1563 

2.8.1 Host and Network Configuration 1564 

ConsoleWorks resides on a VM that was reconfigured for supporting Builds 1 and 3 as described in Table 1565 
2-16 and Table 2-17 respectively. 1566 

Table 2-16 ConsoleWorks Build 1 Deployment 1567 

Name System OS CPU Memory Storage Network 

ConsoleWorks VMWare VM CentOS 7 8x vCPU 8GB 500 GB 
750 GB 

Testbed LAN 
10.100.0.53 

 1568 

Table 2-17 ConsoleWorks Build 3 Deployment 1569 

Name System OS CPU Memory Storage Network 

ConsoleWorks VMWare VM CentOS 7 8x vCPU 8GB 500 GB 
750 GB 

CRS 
192.168.0.65 

 1570 

2.8.2 Installation 1571 

ConsoleWorks version 5.3-1u3 is installed on a CentOS 7 operating system using the following 1572 
procedures. Product installation guides and documentation are available at 1573 
https://support.tditechnologies.com/product-documentation. Follow these steps for installation: 1574 

1. Harden and configure the Operating System: 1575 

a. Log in to the system with privileged access and set the Static IP Address information by 1576 
editing /etc/sysconfig/network-scripts/ifcfg-eth0 using the following settings:  1577 

i. For Build 1 use the following network configuration: 1578 

1) IP Address: 10.100.0.53 1579 

2) Subnet Mask: 255.255.255.0 1580 

3) Gateway: 10.100.0.1 1581 

4) DNS: 10.100.0.17 1582 

ii. For Build 3 use the following network configuration: 1583 

1) IP Address: 192.168.0.65 1584 

https://support.tditechnologies.com/product-documentation
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2) Subnet Mask: 255.255.255.0 1585 

3) Gateway: 192.168.0.2 1586 

4) DNS: 10.100.0.17 1587 

iii. Restart the network service as follows: 1588 

# systemctl restart network 1589 

b. Set the NTP Configuration as follows: 1590 

i. In /etc/ntp.conf, add as the first server entry:  1591 

server 10.100.0.15 1592 

c. Apply the following Department of Defense (DOD) Security Technology Implementation 1593 
Guide (STIG) settings: 1594 

i. Ensure ypserv is not installed using the following command: 1595 

# yum remove ypserv 1596 

ii. Ensure Trivial File Transfer Protocol (TFTP) is not installed using the following 1597 
command: 1598 

# yum remove tftp-server 1599 

iii. Ensure RSH-SERVER is not installed using the following command: 1600 

# yum remove rsh-server 1601 

iv. Ensure File Transfer Protocol (FTP) is not installed using the following command: 1602 

# yum remove vsftpd 1603 

v. Ensure TELNET-SERVER is not installed using the following command: 1604 

# yum remove telnet-server  1605 

vi. Configure SSH to use SSHv2 only. 1606 

1) To disable SSHv1, ensure only Protocol 2 is allowed in the 1607 
/etc/ssh/sshd_config. 1608 

Protocol 2 1609 
PermitRootLogin no 1610 
Ciphers aes128-ctr, aes192-ctr, aes256-ctr, aes128-1611 
cbc 1612 
MACs hmac-sha2 1613 

vii. Disallow authentication using an empty password as follows: 1614 

1) Add PermitEmptyPasswords no to /etc/ssh/sshd_config file.  1615 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 70 

2) Remove any instances of the nullok option in /etc/pam.d/system-auth and 1616 
/etc/pam.d/password-auth files. 1617 

viii. Enable FIPS Mode as follows: 1618 

1) FIPS mode can be enabled by running the command: 1619 

# yum install dracut 1620 
# dracut -f 1621 

2) When step 1) is complete, add fips=1 to the /etc/default/grub file and run 1622 
the command:  1623 

# grub2-mkconfig -o /boot/efi/EFI/redhat/grub.cfg 1624 

3) When step 2) completes, reboot the server with this command: 1625 

# reboot 1626 

ix. Enable server auditing 1627 

1) Ensure events on the server are being recorded for investigation in the 1628 
event of an outage or attack. This can be enabled by running the command: 1629 

# systemctl start auditd.service. 1630 

x. Configure system to only install approved digitally signed packages: 1631 

1) Configure yum to verify the Certificate Authority is from an approved 1632 
organization. To enable this, ensure that gpgcheck=1 is in the 1633 
/etc/yum.conf file. 1634 

xi. Enable the firewall: 1635 

1) To enable the firewall, run the following commands: 1636 

   # yum install firewalld and  1637 

   # systemctl start firewalld. 1638 

2) Check Firewall Zone and confirm only SSH and HTTPS is allowed. Note: the 1639 
default zone is Public and SSH is already permitted. For the 1640 
implementation, we checked the configuration using the following 1641 
command: 1642 

   # firewall-cmd --list-all 1643 

3) Add the HTTPS configuration to the firewall using the following command: 1644 

# firewall-cmd --zone=public --permanent --add-1645 
service=https 1646 

xii. Enable SELinux and set to "targeted": 1647 
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1) Add SELINUX=enforcing and SELINUXTYPE=targeted in the 1648 
/etc/selinux/config file and then reboot the server with this command: 1649 

# reboot 1650 

xiii. Enable Antivirus as follows: 1651 

1) ClamAV is used for the lab implementation using the following commands 1652 
adapted from information found on 1653 
https://www.clamav.net/documents/clam-antivirus-user-manual: 1654 

# yum install -y epel-release 1655 

# yum -y install clamav-server clamav-data 1656 
clamav-update clamav-filesystem clamav clamav-1657 
scanner-systemd clamav-devel clamav-lib clamav-1658 
server-systemd 1659 

2) Update SELinux policy to allow ClamAV to function 1660 

# setsebool -P antivirus_can_scan_system 1 1661 

3) Make a backup copy of the scan.conf file and update to remove the 1662 
Example string from the file using these commands: 1663 

# cp /etc/clamd.d/scan.conf /etc/clamd.d/scan.conf.bk 1664 

# sed -i '/^Example/d' /etc/clamd.d/scan.conf 1665 

4) Uncomment the following line from /etc/clamd.d/scan.conf: 1666 

LocalSocket /var/run/clamd.scan/clamd.sock 1667 

5) Configure freshclam to automatically download updated virus definitions 1668 
using these commands: 1669 

# cp /etc/freshclam.conf /etc/freshclam.conf.bak 1670 

# sed -i -e "s/^Example/#Example/" /etc/freshclam.conf 1671 

6) Manually run freshclam to confirm the settings as follows: 1672 

# freshclam 1673 

7) Start and enable the clamd service with these commands: 1674 

# systemctl start clamd@scan 1675 

# systemctl enable clamd@scan 1676 

8) Ensure log directory is available with this command: 1677 

# mkdir /var/log/clamav 1678 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 72 

9) Create the daily scan script to scan directories of interest. Note: for the lab 1679 
implementation only the /home volume was selected for scanning. 1680 

# vi /etc/cron.daily/clamav_scan.sh 1681 

 1682 

File Contents 1683 
                                         1684 
#!/bin/bash 1685 
SCAN_DIR="/home" 1686 
LOG_FILE="/var/log/clamav/dailyscan.log" 1687 
/usr/bin/clamscan -ri $SCAN_DIR >> $LOG_FILE 1688 

10) Set the file to have execute privilege with this command: 1689 

# chmod +x /etc/cron.daily/clamav_scan.sh 1690 

2. Download and Install the ConsoleWorks packages 1691 

a. Login to TDi Technology Support Portal (https://support.tditechnologies.com/get_con-1692 
soleworks) to download the ConsoleWorks for Linux 5.3-1u3 installation package. Cre-1693 
dentials will be provided by TDi.  1694 

b. After downloading the ConsoleWorks installation package, copy it to the ConsoleWorks 1695 
VM using a Secure Copy (scp) utility. 1696 

c. Follow the procedures from TDi ConsolWorks New Installation and Upgrade Guide for 1697 
Linux Chapter 3: Automated New Installation of ConsoleWorks 1698 

i. During installation, create a New Invocation named "NCCOE". 1699 

ii. Create a new certificate. 1700 

iii. Set the system to automatically start the ConsoleWorks Invocation. 1701 

d. Login to the platform and initiate the offline registration process (Figure 2-43). 1702 

e. Once the license file is obtained, complete the registration process (Figure 2-44). 1703 

https://support.tditechnologies.com/get_consoleworks
https://support.tditechnologies.com/get_consoleworks
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Figure 2-43 ConsoleWorks Registration Screen 1704 

 1705 

Figure 2-44 ConsoleWorks Offline Registration Process 1706 

 1707 

f. This completes the default installation and establishes a basic ConsoleWorks server con-1708 
figuration. For the lab implementation, ConsoleWorks support provided two additional 1709 
add-on packages (XML) files to setup the environment: ONBOARDING_1-DASH-1710 
BOARDS_NCCoE.zip providing preconfigured dashboards for accelerating configurations; 1711 
and NCCOE_ACRs_20210122_083645.zip providing the access control rules, tags, and 1712 
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automation scripts used for the dashboards. These packages are scheduled for inclusion 1713 
in future releases or can be requested from ConsoleWorks. 1714 

i. Prior to installing these packages, a backup of the configuration should be made 1715 
(Figure 2-45) by accessing Admin > Database Management > Backups and click-1716 
ing Create Backup. 1717 

Figure 2-45 ConsoleWorks System Backups 1718 

 1719 

ii. Perform the XML Imports (Figure 2-46) by accessing Admin > Database Manage-1720 
ment > XML Imports following these steps: 1721 

1) Import the Dashboard Add-On XML file. 1722 

2) Import the Supporting Configuration Add-On XML file. 1723 
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Figure 2-46 ConsoleWorks Importing System Configurations and Components 1724 

 1725 

2.8.3 Configuration 1726 

The ConsoleWorks implementation required the following changes to the lab Cisco VPN appliance to 1727 
allow remote users to access the ConsoleWorks system: 1728 

1. Login to the Cisco Firepower Appliance. 1729 

2. Create the Following Destination Network Objects: 1730 

a. For Build 1: 1731 

i. Name: ConsoleWorks 1732 

ii. IP Address: 10.100.0.52 1733 

b. For Build 3: 1734 

i. Name: CRS-NAT-IP 1735 

ii. IP Address: 10.100.0.20 1736 

3. Create the Following VPN-Rule: 1737 
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a. For Build 1: 1738 

i. Action: Allow 1739 

ii. Source Networks: VPN-Pool 1740 

iii. Destination Networks: ConsoleWorks 1741 

iv. Destination Ports: TCP (6): 5176; HTTPS 1742 

b. For Build 3: 1743 

i. Action: Allow 1744 

ii. Source Networks: VPN-Pool 1745 

iii. Destination Networks: CRS-NAT-IP 1746 

iv. Destination Ports: TCP (6): 5176; HTTPS 1747 

ConsoleWorks is then configured as follows. For configuration procedures, please see the ConsoleWorks 1748 
documentation available at https://support.tditechnologies.com/product-documentation. 1749 

1. Configure ConsoleWorks Password Rules (Figure 2-47): 1750 

Figure 2-47 ConsoleWorks Password Settings 1751 

 1752 

2. Add user accounts: 1753 

a. NCCOE_ADMIN  1754 

https://support.tditechnologies.com/product-documentation
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b. NCCOE_USER 1755 

3. Configure the Graphical Gateway to allow users to use RDP within ConsoleWorks following 1756 
these steps (Figure 2-48): 1757 

a. Name: LOCAL_GG 1758 

b. Description: Local GUI Gateway 1759 

c. Host: 127.0.0.1 1760 

d. Port: 5172 1761 

e. Enabled: Selected 1762 

f. Encrypt Connection: Selected 1763 

Figure 2-48 ConsoleWorks Add the Local Graphical Gateway for RDP Access 1764 

 1765 

4. Configure Device Types to organize the registered devices within the system as follows: 1766 

a. Enter the information for the supported device types as shown in the example device 1767 
type (Figure 2-49) for each type listed in Table 2-18 (and shown in Figure 2-50). 1768 
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Table 2-18 ConsoleWorks Device Type List 1769 

Name Description Parent Device Type Order 

NETWORKING Devices supporting networked com-
munications 

 1 

IT_FWROUTER Network Router/Firewall for support-
ing IT Communications 

NETWORKING 1 

IT_SWITCH Network switch supporting IT com-
munications 

NETWORKING 1 

OT_FWROUTER ICS Firewall/Router for ICS Network 
Separation 

NETWORKING 1 

OT_SWITCH ICS Switch for supporting OT Subnets NETWORKING 1 

SERVERS Devices for providing one or more 
IT/OT Services 

 1 

IT_SERVERS Servers providing IT Services SERVERS 1 

OT_SERVERS Servers providing OT Services SERVERS 1 

WORKSTATIONS Computers used to support IT/OT Op-
erations 

 1 

HMI Specialized workstation supporting 
human-machine interfaces 

WORKSTATIONS 1 

IT_WORKSTATIONS Computers used by users to support 
IT Operations 

WORKSTATIONS 1 

OT_WORKSTATIONS Computers used by users to support 
OT Operations 

WORKSTATIONS 1 
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Figure 2-49 ConsoleWorks Example Device Type Definition 1770 

 1771 

Figure 2-50 ConsoleWorks List of Device Types 1772 

 1773 
5. Configure Devices for each system within the testbed that is accessible from ConsoleWorks. 1774 
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Figure 2-51 ConsoleWorks Example Device Definition 1775 

 1776 

a. For Build 1 (PCS), enter the information for the devices as shown in the example device 1777 
(Figure 2-51) for each device listed in Table 2-19 (Figure 2-52). 1778 

Table 2-19 ConsoleWorks PCS (Build 1) Devices 1779 

Name Description Device Type 

DMZ_HISTORIAN Historian in DMZ Subnet IT_SERVER 

PCS_HISTORIAN Local Historian in PCS Subnet OT_SERVER 

PCS_HMI PCS HMI Workstation HMI 

PCS_ROUTER PCS Boundary Firewall/Router OT_FWROUTER 

PCS_SWITCH_VLAN1 PCS VLAN 1 OT Switch OT_SWITCH 

PCS_SWITCH_VLAN2 PCS VLAN 2 OT Switch OT_SWITCH 

PCS_WORKSTATION PCS Engineering Workstation OT_WORKSTATIONS 
 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 81 

Figure 2-52 ConsoleWorks List of PCS (Build 1) Devices 1780 

 1781 

b. For Build 3 (CRS) , enter the information for the devices as shown in the example device 1782 
(Figure 2-51) for each device listed in Table 2-20 (also shown in Figure 2-53). 1783 

Table 2-20 ConsoleWorks CRS (Build 3) Devices 1784 

Name Description Device Type 

DMZ_HISTORIAN Historian in DMZ Subnet IT_SERVER 

CRS_HISTORIAN Local Historian in CRS Subnet OT_SERVER 

CRS_HMI CRS HMI Workstation HMI 

CRS_ROUTER CRS Boundary Firewall/Router OT_FWROUTER 

CRS_SWITCH_CONTROL OT Switch for Control Network OT_SWITCH 

CRS_SWITCH_FIELD OT Switch for Field Network OT_SWITCH 

CRS_WORKSTATION CRS Engineering Workstation OT_WORKSTATIONS 

CRS_STATION1 Machining Station #1 OT_WORKSTATIONS 

CRS_STATION2 Machining Station #2 OT_WORKSTATIONS 

CRS_STATION3 Machining Station #3 OT_WORKSTATIONS 

CRS_STATION4 Machining Station #4 OT_WORKSTATIONS 
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Figure 2-53 ConsoleWorks List of CRS (Build 3) Devices 1785 

 

6. Configure Graphical Connections for the PC (RDP) based devices.  1786 
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Figure 2-54 ConsoleWorks Example RDP Configuration 1787 

 

a. For Build 1 (PCS), enter the information for the Graphical Connections as shown in the 1788 
example (Figure 2-54) for each graphical connection listed in Table 2-21 (also shown in 1789 
Figure 2-55). For each entry, the following are common settings for all graphical connec-1790 
tions: 1791 

i. Under Gateway, click Add and select LOCAL_GG. 1792 

ii. Single Session Connection: Checked 1793 

iii. Allow Join with Active Session: Checked 1794 

iv. Under Recordings: 1795 

1) Directory: /opt/ConsoleWorks/NCCOE/graphical 1796 

2) Retain Records: Checked 1797 

3) Auto-Purge: 0 1798 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 84 

4) Max Size: 0 1799 

5) End Session when Max Size Reached: Checked 1800 

6) Max Time: 0 1801 

v. Authentication 1802 

1) Specify local or domain credentials, which are securely stored by 1803 
ConsoleWorks, to allow complex passwords/credentials without having to 1804 
share between users. 1805 

2) Ignore Certificate Errors: Checked only if self-signed certificates are in use. 1806 

vi. Performance 1807 

1) Display Width: 1900 1808 

2) Display Height: 1200 1809 

Table 2-21 ConsoleWorks PCS (Build 1) Graphical Connections 1810 

Name Device Type Host Port 

DMZ_HISTORIAN DMZ_HISTORIAN RDP 10.100.1.4 3389 

PCS_HISTORIAN PCS_HISTORIAN RDP 172.16.2.14 3389 

PCS_HMI_RDP PCS_HMI RDP 172.16.2.4 3389 

PCS_WORKSTATION_RDP PCS_WORKSTATION RDP 172.16.3.10 3389 
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Figure 2-55 ConsoleWorks List of PCS (Build 1) RDP Connections 1811 

 

b. For Build 3 (CRS), enter the information for the graphical connections as shown in the 1812 
example (Figure 2-54) for each graphical connection listed in Table 2-22 (also shown in 1813 
Figure 2-56). For each entry, the following are common settings for all graphical connec-1814 
tions. 1815 

i. Under Gateway, click Add and select LOCAL_GG. 1816 

ii. Under Recordings, use these settings: 1817 

1) Directory /opt/ConsoleWorks/NCCOE/graphical 1818 

2) Retain Records Checked 1819 

3) Auto-Purge: 0 1820 

4) Max Size: 0 1821 

5) End Session when Max Size Reached: Checked 1822 

6) Max Time: 0 1823 

iii. Authentication: 1824 

1) Specify local or domain credentials, which are securely stored by 1825 
ConsoleWorks, to allow complex passwords/credentials without having to 1826 
share between users. 1827 
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iv. Performance 1828 

1) Display Width: 1900 1829 

2) Display Height: 1200 1830 

Table 2-22 ConsoleWorks CRS (Build 3) Graphical Connections 1831 

Name Device Type Host Port 

DMZ_HISTORIAN DMZ_HISTORIAN RDP 10.100.1.4 3389 

CRS_HISTORIAN CRS_HISTORIAN RDP 192.168.0.21 3389 

CRS_WORKSTATION CRS_WORKSTATION RDP 192.168.0.20 3389 
 1832 

Figure 2-56 ConsoleWorks List of CRS (Build 3) RDP Connections 1833 

 1834 

7. Configure console connections for non-graphical (e.g., SSH) interfaces to devices (Figure 2-57). 1835 
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Figure 2-57 ConsoleWorks Example Console (SSH) Connection 1836 
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Figure 2-58 ConsoleWorks Example Console (Web Forward) Connection 1837 

 1838 

a. For Build 1 (PCS), enter the information for the Console Connections as shown in the ex-1839 
amples (Figure 2-57 and Figure 2-58) for each console connection listed in Table 2-23 1840 
(also shown in Figure 2-59). For each entry, the following are common settings for all 1841 
console connections. 1842 

i. Under Connection Details: 1843 

1) Specify the username and password, which are securely stored by Console-1844 
Works, to allow complex passwords/credentials without having to share 1845 
between users.   1846 

Table 2-23 ConsoleWorks PCS (Build 1) Console Connections 1847 

Name Device Connector Host Port 

PCS_ROUTER PCS_ROUTER SSH with Password 10.100.2.8 22 

PCS_VLAN1 PCS_SWITCH_VLAN1 SSH with Password 172.16.1.3 22 
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Name Device Connector Host Port 

PCS_VLAN2 PCS_SWITCH_VLAN2 SSH with Password 172.16.2.2 22 
 1848 

Figure 2-59 ConsoleWorks List of PCS (Build 1) Console Connections 1849 

 1850 

b. For Build 3 (CRS), enter the information for the console connections as shown in the ex-1851 
ample (Figure 2-57 and Figure 2-58) for each console connection listed in Table 2-24 1852 
(Figure 2-60). For each entry, the following are common settings for all console connec-1853 
tions. 1854 

i. Under Connection Details 1855 

1) Specify the username and password, which are securely stored by Console-1856 
Works, to allow complex passwords/credentials without having to share 1857 
between users.   1858 

Table 2-24 ConsoleWorks CRS (Build 3) Console Connections 1859 

Name Device Connector Host Port 

CRS_CONTROL_LAN CRS_SWITCH_CONTROL Web Forward 192.168.0.239 80 

CRS_FIELD_LAN CRS_SWITCH_FIELD SSH with Password 192.168.1.10 22 
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Name Device Connector Host Port 

CRS_ROUTER CRS_ROUTER SSH with Password 192.168.0.2 22 

CRS_STATION1 CRS_STATION1 Web Forward 192.168.1.101 80 

CRS_STATION2 CRS_STATION2 Web Forward 192.168.1.102 80 

CRS_STATION3 CRS_STATION3 Web Forward 192.168.1.103 80 

CRS_STATION4 CRS_STATION4 Web Forward 192.168.1.104 80 

HMI CRS_HMI Web Forward 192.168.0.98 80 
 1860 

Figure 2-60 ConsoleWorks List of CRS (Build 3) Console Connections 1861 

 1862 

8. Configure tags to support profiles and access controls. 1863 
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Figure 2-61 ConsoleWorks List of Tags for PCS (Build 1) 1864 
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Figure 2-62 ConsoleWorks Example Tag Definition Screen 1865 

 1866 

a. For Build 1 (PCS) the following tags were created as shown in Figure 2-61. Figure 2-62 shows an 1867 
example of a single tag.  1868 

i. Name: PCS_GENERAL 1869 

1) Under Dashboards, click Add and select Devices.  1870 

2) Under Custom UI Classes click Add and select: 1871 

a) DEVICE_LISTGRID 1872 

b) LISTGRID 1873 

3) Under Devices, click Add and select: 1874 

a) DMZ_HISTORIAN 1875 

b) PCS_HISTORIAN 1876 

c) PCS_HMI 1877 
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i. PCS_WORKSTATION 1878 

4) Under Graphical Connections, click Add and select: 1879 

a) DMZ_HISTORIAN 1880 

b) PCS_HISTORIAN 1881 

c) PCS_HMI_RDP 1882 

d) PCS_WORKSTATION_RDP 1883 

ii. Name: PCS_ADMIN: 1884 

1) Under Dashboards click Add and select Devices  1885 

2) Under Custom UI Classes click Add and select: 1886 

a) DEVICE_LISTGRID 1887 

b) LISTGRID 1888 

3) Under Consoles, click Add and select: 1889 

a) PCS_ROUTER 1890 

b) PCS_SWITCH_VLAN1 1891 

c) PCS_SWITCH_VLAN2 1892 

4) Under Devices, click Add and select: 1893 

a) PCS_ROUTER 1894 

b) PCS_SWITCH_VLAN1 1895 

c) PCS_SWITCH_VLAN2 1896 

b. For Build 3 (CRS) Create the following: 1897 

i. Name: NCCOE_CRS 1898 

1) Under Dashboards, click Add and select Devices.  1899 

2) Under Custom UI Classes, click Add and select: 1900 

a) DEVICE_LISTGRID 1901 

b) LISTGRID 1902 

3) Under Consoles, click Add and select: 1903 

a) CRS_STATION1 1904 

b) CRS_STATION2 1905 

c) CRS_STATION3 1906 
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d) CRS_STATION4 1907 

e) HMI 1908 

4) Under Devices, click Add and select: 1909 

a) CRS_HMI 1910 

b) CRS_STATION1 1911 

c) CRS_STATION2 1912 

d) CRS_STATION3 1913 

e) CRS_STATION4 1914 

f) CRS_WORKSTATION 1915 

5) Under Graphical Connections, click Add and select:  1916 

a) CRS_WORKSTATION 1917 

ii. Name: NCCOE_ADMIN 1918 

1) Under Dashboards click Add and select Devices  1919 

2) Under Custom UI Classes click Add and select: 1920 

a) DEVICE_LISTGRID 1921 

b) LISTGRID 1922 

3) Under Consoles click Add and select: 1923 

a) CRS_CONTROL_LAN 1924 

b) CRS_FIELD_LAN 1925 

c) CRS_ROUTER 1926 

4) Under Devices click Add and select: 1927 

a) CRS_SWITCH_CONTROL 1928 

b) CRS_SWITCH_FIELD 1929 

c) CRS_ROUTER 1930 

9. Configure profiles to provide user accounts with granular access controls to available resources 1931 
(Figure 2-63). 1932 
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Figure 2-63 ConsoleWorks Example Profile 1933 

 1934 

a. For Build 1 (PCS) the following profiles were created: 1935 

i. PCS_GENERAL 1936 

1) Under Users click Add and select 1937 

a) NCCOE_USER 1938 

2) Under Tags click Add and select 1939 

a) PCS_GENERAL 1940 

b) TBA_DASHBOARD_VIEW 1941 

c) TBA_DEVICE_CONNECT 1942 

d) TBA_SUBSET 1943 

ii. PCS_ADMIN  1944 
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1) Under Users, click Add and select: 1945 

a) NCCOE_ADMIN 1946 

2) Under Tags, click Add and select: 1947 

a) PCS_ADMIN 1948 

b) TBA_DASHBOARD_VIEW 1949 

c) TBA_DEVICE_CONNECT 1950 

d) TBA_SUBSET 1951 

e) CONSOLE_CONTROL_ACCESS 1952 

f) CONSOLE_VIEW_ACCESS 1953 

b. For Build 3 (CRS) create the following: 1954 

i. NCCOE_CRS profile for the NCCOE_USER with access to Tags:  1955 

1) Under Users, click Add and select: 1956 

a) NCCOE_USER 1957 

2) Under Tags click Add and select the following: 1958 

a) NCCOE_CRS 1959 

b) TBA_DASHBOARD_VIEW 1960 

c) TBA_DEVICE_CONNECT 1961 

d) TBA_SUBSET 1962 

e) CONSOLE_CONTROL_ACCESS 1963 

f) CONSOLE_VIEW_ACCESS 1964 

ii. NCCOE_ADMIN profile for the NCCOE_USER with access to Tags:  1965 

1) Under Users, click Add and select: 1966 

a) NCCOE_ADMIN 1967 

2) Under Tags click Add and select the following: 1968 

a) NCCOE_ADMIN 1969 

b) TBA_DASHBOARD_VIEW 1970 

c) TBA_DEVICE_CONNECT 1971 

d) TBA_SUBSET 1972 

e) CONSOLE_CONTROL_ACCESS 1973 
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f) CONSOLE_VIEW_ACCESS 1974 

2.9 Tenable.OT 1975 

The Tenable.OT implementation in Build 1 consists of a single appliance to meet the BAD, hardware 1976 
modification, firmware modification, and software modification capabilities. Tenable.OT utilizes a 1977 
combination of passive and active sensors to monitor critical networks for anomalies and active 1978 
querying to retrieve information about endpoints in the PCS environment. 1979 

2.9.1 Host and Network Configuration 1980 

Tenable.OT is installed and configured to support the PCS environment in Build 1. The overall build 1981 
architecture is described in Figure B-1, and the Tenable.OT specific components are listed in Table 2-25.  1982 

Table 2-25 Tenable.OT Appliance Details. 1983 

Name System OS CPU Memory Storage Network 

Tenable.OT Model: NCA-
4010C-IG1 

CentOS 7 Intel Xeon D-1577 64 GB 64 Gb 
2 TB 
2 TB 

Testbed LAN 
10.100.0.66 

 

2.9.2 Installation 1984 

The Tenable.OT (Version 3.8.17) appliance is installed in a rack with network connections for the 1985 
Management/Query traffic on Port 1 and SPAN traffic on Port 2 of the appliance. Documentation for 1986 
Tenable.OT is available at https://docs.tenable.com/Tenableot.htm.   1987 

2.9.3 Configuration 1988 

This section outlines the steps taken to configure Tenable.OT to fully integrate and support the PCS 1989 
environment. These include setting NTP settings to synchronize the system time with the lab time 1990 
source, configuring the scanning options for the PCS environment, and configuring network objects and 1991 
policies to enhance alerting for DMZ specific remote connections.  1992 

1. Enable connection through PCS Firewall 1993 

a. Add the following rules (Table 2-26) to the PCS Firewall to allow Tenable.OT to perform 1994 
asset discovery and controller scanning. 1995 

Table 2-26 Firewall Rules for Tenable.OT 1996 

Rule Type Source Destination Protocol:Port(s) Purpose 

Allow 10.100.0.66 172.16.0.0/22 ICMP Asset Discovery 

Allow 10.100.0.66 172.16.2.102 TCP:44818,2222 PLC Controller Scans 
 

2. Set NTP Services as follows: 1997 

https://docs.tenable.com/Tenableot.htm
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a. After logging into the appliance, navigate to Local Settings > Device. 1998 

b. To the right of System Time, click Edit to display the time service options (Figure 2-64). 1999 

c. Enter the NTP Server information: 10.100.0.15 2000 

d. Click Save. 2001 

Figure 2-64 Tenable.OT Local Device Setting for NTP Service 2002 

 2003 

3. Configure Scanning Options as follows: 2004 

a. Set Asset Discovery Scans: 2005 

i. Navigate to Local Settings > Queries > Asset Discovery (Figure 2-65) 2006 

ii. Enable both scan options. 2007 

iii. Select Edit next to Asset Discovery. 2008 

1) Enter the following CIDR for the PCS, DMZ, and Testbed networks: 2009 

a) 172.16.0.0/22 2010 

b) 10.100.0.0/24 2011 

c) 10.100.1.0/24 2012 

2) Set the scan properties as follows: 2013 

a) Number of Assets to Poll Simultaneously: 10 2014 

b) Time Between Discovery Queries: 1 second 2015 

c) Frequency: Daily 2016 

d) Repeats Every: 7 Days 2017 

e) Repeats at: 9:00 PM 2018 

3) Click Save. 2019 
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Figure 2-65 Tenable.OT Asset Discovery Settings 2020 

 2021 

b. Set Controller Scans as follows: 2022 

i. Navigate to Local Settings > Queries > Controller (Figure 2-66) 2023 

ii. Enable the following options: 2024 

1) All Controller Queries 2025 

2) Periodic Snapshots 2026 

3) Controller Discovery 2027 

4) Controller Status Query 2028 

5) Controller Details Query 2029 

6) Backplane Query 2030 
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Figure 2-66 Tenable.OT Controller Scans 2031 

 2032 

c. Set Network Scans as follows: 2033 

i. Navigate to Local Settings > Queries > Network (Figure 2-67) 2034 

ii. Enable the following options: 2035 

1) All Network Queries 2036 

2) DNS Query 2037 

3) ARP Query 2038 

4) NetBIOS Query 2039 
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Figure 2-67 Tenable.OT Network Scan Settings 2040 

 2041 

4. Create Group Object as follows: 2042 

a. Set DMZ Group Object 2043 

i. Navigate to Groups > Asset Groups 2044 

ii. Click Create Asset Group to initiate the Wizard process.  2045 

1) Select IP Range for the Asset Group Type (Figure 2-68) and Click Next. 2046 

2) Enter the asset name in Name, the starting IP address in Start IP, and the 2047 
ending IP Address in End IP (Figure 2-69) and Click Create. 2048 

Figure 2-68 Tenable.OT Create Asset Group Type 2049 
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Figure 2-69 Tenable.OT Create Asset Group Definition 2050 

 2051 

5. Create Policy to Detect External RDP Traffic: 2052 

a. In the left side navigation, click Policies.  2053 

b. Click Create Policy in the upper right corner of the page (Figure 2-70), then follow these 2054 
steps: 2055 

i. For the Event Type (Figure 2-71), select as a Network Events > RDP Connection 2056 
(Authenticated) and click Next.  2057 

ii. For the Policy Definition (Figure 2-72), specify the following parameters and click 2058 
Next: 2059 

1) Policy Name: Enter "External RDP Communications" 2060 

2) Source Group: Select "In" from the first drop-down, and "DMZ" from the 2061 
second drop-down. 2062 

3) Destination Group: Select "In" from the first drop-down and select "In Any 2063 
Asset" from the second drop-down. 2064 

4) Schedule Group: Select "In" from the first drop-down, and "In Any Time" 2065 
from the second drop-down. 2066 

iii. For the Policy Action (Figure 2-73), select Medium Sensitivity and click Create. 2067 
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Figure 2-70 Tenable.OT Policy Settings 2068 

 2069 

Figure 2-71 Tenable.OT Create Policy – Event Type Options 2070 

 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 104 

Figure 2-72 Tenable.OT Create Policy - Definition 2071 
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Figure 2-73 Tenable.OT Create Policy - Actions 2072 

 

2.10 VMware Carbon Black App Control 2073 

VMWare Carbon Black App Control is an endpoint protection tool that provides multiple file integrity 2074 
and application features, including application allow/deny listing and file modification or deletion 2075 
protection. Carbon Black was used for Builds 1 and 4 as the application allowlisting (AAL) and file 2076 
integrity checking tool.  2077 

2.10.1 Host and Network Configuration 2078 

The following tables (Table 2-27, Table 2-28, and Table 2-29) detail the host and network configuration 2079 
of the Carbon Black App Control server for PCS and CRS.  2080 
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Table 2-27 Carbon Black App Control Domain Hosts Deployment 2081 

Name System OS CPU Memory Storage Network 

Carbon Black 
Server 

VMware 
ESXi VM 

Windows 
Server 2016 
Datacenter 

4 8GB 500GB Testbed LAN 
10.100.0.52 
 

Windows 
Server 

Hyper-V VM Windows 
Server 2012 R2 

2 6GB 65GB Testbed LAN 
10.100.0.25 

OSIsoft Pi 
Server 

Hyper-V VM Windows 
Server 2016 
Standard 

4 8GB 80GB/171GB DMZ 
10.100.1.4 

Dispel VDI Hyper-V VM Windows 
Server 2016 
Datacenter 

2 8GB 126GB N/A 

 

Table 2-28 Carbon Black App Control PCS Hosts Deployment 2082 

Name System OS CPU Memory Storage Network 

PCS HMI 
Workstation 

Supermicro 
Z97X-Ud5H 

Windows 7 4 8GB 233GB PCS 
172.16.1.4 

PCS Engineer-
ing Work-
station  

Supermicro 
Z97X-Ud5H 

Windows 7 4 16GB 465GB PCS 
172.16.3.10 

 

Table 2-29 Carbon Black App Control CRS Hosts Deployment 2083 

Name System OS CPU Memory Storage Network 

CRS Engi-
neering 
Workstation 

Dell Preci-
sion T5610 

Windows 10 8 16GB 465GB CRS Supervi-
sory 
192.168.0.20 

CRS OSIsoft 
Pi Server 

Hyper-V VM Windows 
Server 2016 
Standard 

4 16GB 80GB/171GB CRS Supervi-
sory 
192.168.0.21 

 

2.10.2 Installation 2084 

Prepare the Carbon Black App Control Server (fka CB_Protection) in accordance with the CB Protection 2085 
Operating Environment Requirements v8.1.6 document that is provided for installation. This document, 2086 
and all Carbon Black documentation, can be found on the website https://community.carbonblack.com. 2087 

1. Install Carbon Black App Control Server (fka CB_Protection) using these steps: 2088 

https://community.carbonblack.com/
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a. Created nccoeCarbon domain user account on LAN AD to be used for installation and 2089 
administration of CB App Control Server and add this user to the local administrators’ 2090 
group on the server. 2091 

b. Install SQL Server Express 2017 according to the CB Protection SQL Server Configuration 2092 
v8.1.4 document. 2093 

c. Install the CB App Control Server according to the CB Protection Server Install Guide 2094 
v8.1.6 document. 2095 

2.10.3 Configuration 2096 

Follow these steps to configure Windows Server 2016: 2097 

1. On the Carbon Black App Control Server, configure Windows Server 2016: 2098 

a. Based on Carbon Black documentation (Figure 2-74), Windows Server 2016 will need to 2099 
have the following features for the Internet Information Services (IIS) role enabled for 2100 
Carbon Black to work (Figure 2-75). 2101 
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Figure 2-74 Excerpt from Carbon Black Documentation on Support Server Requirements 2102 
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Figure 2-75 IIS Configuration for Carbon Black, Server Roles 2103 

 

2. Manually update the Windows Server firewall configuration to allow inbound port 41002 traffic 2104 
from CB App Control clients/agents. 2105 

3. Configure Policy in the Carbon Black Console using these steps: 2106 

a. In the CB App Control Console, go to Rules > Policies. 2107 

b. Create a new policy with the desired enforcement level. In this case, a high enforcement 2108 
level was chosen to actively block execution of unapproved or banned executables (Fig-2109 
ure 2-76). 2110 
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Figure 2-76 Carbon Black Policy Edit 2111 

 2112 

4. Enable AD Integration Features as follows: 2113 

a. Enable AD integration features on CB App Control Console for domain user account 2114 
login and AD-Based Policy mapping. AD-Based Policy mapping allows automatic policy 2115 
assignment to be mapped to AD users, groups, computers, organizational units (OUs), 2116 
etc., as configured by a CB App Control Console administrator (Figure 2-77). 2117 
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Figure 2-77 Carbon Black App Control System Configuration 2118 

 2119 

5. Add users from AD and assign policies: 2120 

a. Add "Test Users" OU from the AD to policy mapping settings and assign the "High-2121 
Enfcmt_NCCOE" policy (Figure 2-78).  2122 

This OU includes the "nccoeUser" and "nccoeAdmin" user accounts created for the test 2123 
scenarios. This policy will be automatically applied to these users logged in on any com-2124 
puter that is running the CB Protection Agent. The "HighEnfcmt_NCCOE" policy is set to 2125 
High Enforcement level, which will actively block all unapproved or banned files, applica-2126 
tions, or devices.  2127 
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Figure 2-78 Carbon Black App Control AD Policy Mappings 2128 

 2129 

6. Download and install CB App Control Agent from CB App Control Server  2130 

(The process outlined below uses the CRS Engineering Workstation as an example, but the process 2131 
was the same for all the agent computers.). Follow these steps: 2132 

a. Open the browser on the CRS Engineering Workstation and enter the URL to download 2133 
the agent installer: https://CB-Server.lan.lab/hostpkg. This URL is on the Carbon Black 2134 
server itself and is accessed on the local network. CB-Server.lan.lab is the full host name 2135 
we gave this server during installation. 2136 

i. If the host cannot access CB-Server.lan.lab, update the environment DNS Server 2137 
by mapping the IP address, 10.100.0.52, to CB-Server.lan.lab or add the mapping 2138 
to the local host file.  2139 

b. Download the Windows CB App Control Agent installer from the CB App Control Server 2140 
and install on the CRS Engineering Workstation (Figure 2-79). 2141 

https://cb-server.lan.lab/hostpkg
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Figure 2-79 Carbon Black Agent Download 2142 

 2143 

c. Check the CB App Control Console to verify communication and initialization of the new 2144 
CRS Engineering Workstation agent computer on the CB App Control Server (Figure 2145 
2-80).  2146 

Figure 2-80 Carbon Black App Control Computers 2147 

 2148 

d. Approve all new trusted files and publishers that were added from the CRS Engineering 2149 
Workstation to the catalog on the CB App Control Server. 2150 

e. This image (Figure 2-81) shows the Cb Protection - Files page of the CB App Control Con-2151 
sole. 2152 
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Figure 2-81 Carbon Black App Control File Catalog 2153 

 2154 

2.11 Windows Software Restriction Policy (SRP) 2155 

Windows SRP is a feature that is a part of the Windows operating system. It identifies applications that 2156 
are running on any domain-controlled computer, and it can block any programs that have not been 2157 
allow-listed. Configuring Windows SRP is done through Group Policy Object management. Windows SRP 2158 
was used for AAL in Builds 2 and 3. 2159 

2.11.1 Host and Network Configuration 2160 

Windows SRP configuration is established by Group Policy Objects (GPOs) located on the two AD 2161 
servers. The domain controllers were common across all builds as detailed in Table 2-30. 2162 

Table 2-30 Windows SRP Domain Servers 2163 

Name System OS CPU Memory Storage Network 

AD (Primary) 
Server 

Hyper-V VM Windows 2012R2 2x vCPU 2 GB 45 GB Testbed LAN 
10.100.0.17 

AD (Second-
ary) Server 

Hyper-V VM Windows 2012R2 1x vCPU 2 GB 21 GB Testbed LAN 
10.100.0.13 

 2164 

The following systems were configured to utilize Windows SRP for each build. Additional details for each 2165 
build are available in Section 4.5 of Volume B. 2166 

Build 2 supports the testing within the PCS environment. The overall build architecture is provided in 2167 
Figure B-2. The Windows SRP specific components are in Table 2-31. 2168 



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 115 

Table 2-31 Windows SRP Build 2 Deployment 2169 

Name System OS CPU Memory Storage Network 

Windows 
Server  

Hyper-V VM Windows 2012R2 2x vCPU 6 GB 65 GB Testbed LAN 
10.100.0.25 

Dispel VDI Hyper-V VM Windows 2016 2x vCPU 8 GB 126 GB DMZ LAN 
10.100.1.61 

DMZ Historian Hyper-V VM Windows 2016 4x vCPU 8 GB 80 GB, 
171 GB 

DMZ LAN 
10.100.1.4 

Engineering 
Workstation 

HP Z230 
Workstation 

Windows 7 Intel i5-
4570 

16 GB 465 GB 172.16.3.10 

HMI Host  Generic Windows 7 Intel i5-
4590 

8 GB 233 GB PCS VLAN 1 
172.16.1.4 

 

Build 3 supports the testing within the CRS environment. The overall build architecture is provided in 2170 
Figure B-3. The Windows SRP specific components are in Table 2-32. 2171 

Table 2-32 Windows SRP Build 3 Deployment 2172 

Name System OS CPU Memory Storage Network 

Windows 
Server  

Hyper-V VM Windows 2012R2 2x vCPU 6 GB 65 GB Testbed LAN 
10.100.0.25 

DMZ Historian Hyper-V VM Windows 2016 4x vCPU 8 GB 80 GB, 
171 GB 

DMZ LAN 
10.100.1.4 

Engineering 
Workstation 

Dell T5610 Windows 10 2x Intel 
E3-2609 
v2 

16 GB 465 GB CRS Supervi-
sory LAN 
192.168.0.20 

CRS Local His-
torian 

Hyper-V VM Windows 2016 4x vCPU 16 GB 80 GB, 
171 GB 

CRS Supervi-
sory LAN 
192.168.0.21 

 

2.11.2 Installation 2173 

Windows SRP is a feature of the Windows operating system and therefore did not require any specific 2174 
installation for use in the project. 2175 

2.11.3 Configuration 2176 

The Windows SRP configuration required setting GPOs on the AD servers to enable the policy on all 2177 
hosts that were part of the Windows domain. Additionally, hosts that were not part of the Windows 2178 
Domain had GPO settings configured locally to the host. Follow these steps to configure AD with user 2179 
accounts and set enforcement policies: 2180 
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1. Set up AD with a “Test User” OU and add the NCCOE User (nccoeUser) and Admin (nccoeAdmin) 2181 
accounts for this project to the OU. 2182 

2. To allow the NCCOE Admin account to be included as a local administrator within the 2183 
environment, modify the Default Domain GPO to add Administrators to Restricted Group and 2184 
include the NCCOE Admin account. 2185 

3. To support applying GPOs as local settings to non-domain computers, download LGPO.zip from 2186 
Microsoft Security Compliance Toolkit 1.0 available at https://www.microsoft.com/en-2187 
us/download/details.aspx?id=55319. 2188 

4. Review the National Security Agency (NSA) Guidance for Application Whitelisting using Software 2189 
Restriction Policies and Guidelines for Application Whitelisting ICSs available at 2190 
https://apps.nsa.gov/iaarchive/library/reports/application-whitelisting-using-srp.cfm and 2191 
https://apps.nsa.gov/iaarchive/library/ia-guidance/security-configuration/industrial-control-2192 
systems/guidelines-for-application-whitelisting-industrial-control-systems.cfm respectively. 2193 

5. Create the Windows SRP GPO with the following settings: 2194 

a. From the Enforcement Properties dialog (Figure 2-82): 2195 

i. Select the All Software Files radio button. 2196 

ii. Select the All Users radio button. 2197 

https://www.microsoft.com/en-us/download/details.aspx?id=55319
https://www.microsoft.com/en-us/download/details.aspx?id=55319
https://apps.nsa.gov/iaarchive/library/reports/application-whitelisting-using-srp.cfm
https://apps.nsa.gov/iaarchive/library/ia-guidance/security-configuration/industrial-control-systems/guidelines-for-application-whitelisting-industrial-control-systems.cfm
https://apps.nsa.gov/iaarchive/library/ia-guidance/security-configuration/industrial-control-systems/guidelines-for-application-whitelisting-industrial-control-systems.cfm
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Figure 2-82 Setting Enforcement Properties 2198 

 2199 

b. In the Group Policy Management Editor, in the Security Levels folder: 2200 

i. Double-click the Disallowed security level to open the Disallowed Properties win-2201 
dow. 2202 

ii. Click the Set as Default radio button (Figure 2-83) to configure SRP in allowlist 2203 
mode. After completing this step, only programs in the paths specified by the en-2204 
vironment variables SYSTEMROOT (typically C:\Windows), PROGRAMFILES 2205 
(C:\Program Files), and PROGRAMFILES(x86) (C:\Program Files (x86)) are permit-2206 
ted to execute. These path rules are automatically added when the "Disallowed" 2207 
security level is set as the default. 2208 
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Figure 2-83 Setting Security Level Default 2209 

 2210 

c. Customize the Allowlist Rules to enhance security by disallowing specific subfolders in 2211 
the default allowed paths and to support organization application requirements. 2212 

i. Click the Additional Rules folder and apply the rules shown in Figure 2-84. This 2213 
figure combines the NSA recommended path settings in addition to lab applica-2214 
tion requirements and for disabling installers and other executable content as in-2215 
dicated in the comments. Organizations should audit their environments to deter-2216 
mine the appropriate rules to define within the policy. 2217 
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Figure 2-84 Additional Rules Defined for Lab Environment 2218 
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6. Link the GPO to the Test User OU: 2219 

a. In the Group Policy Management tool, right click the “Test User” OU and select Link an 2220 
Existing GPO from the pop-up menu (Figure 2-85). 2221 

Figure 2-85 Menu Options for Accessing the Link an Existing GPO Option 2222 
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b. In the dialog box, select the Windows SRP GPO Object from the list and click OK (Figure 2223 
2-86). 2224 

Figure 2-86 Dialog Box for Selecting GPO to Link 2225 

 2226 

(Optional) Install GPO as the local policy on non-domain systems; for systems that are not joined 2227 
to the domain, the nccoeUser and nccoeAdmin accounts are created as local user and 2228 
administrator accounts, respectively. Additionally, the Windows SRP GPO is manually applied to 2229 
the local system using the LGPO.exe application contained in the ZIP file from Step 3. 2230 

c. Create a Backup of the Windows SRP GPO Object: 2231 

i. From the Group Policy Manager, select the Group Policy Objects folder and right-2232 
click on the Windows SRP GPO object. 2233 

ii. Select the Back Up… option from the pop-up menu. 2234 

iii. In the dialog box, choose a destination location such as C:\Backup GPO Folder or 2235 
some other convenient location to place the files and click Back Up. 2236 

d. Copy the LGPO.exe along with the files created in the previous step to the non-domain 2237 
computer system. 2238 

e. Login as an administrator on the non-domain computer and navigate to the {GUID}\Do-2239 
mainSysvol\GPO\User folder, which should contain the registory.pol file for the GPO. 2240 
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f. Execute the following commands to apply the settings to the local nccoeUser and 2241 
nccoeAdmin accounts: 2242 

lgpo.exe /u:nccoeUser registory.pol  2243 

lgpo.exe /u:nccoeAdmin registory.pol 2244 
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Appendix A List of Acronyms 2245 

AAL     Application Allowlisting 2246 

AD     Active Directory 2247 

AF    Asset Framework 2248 

BAD     Behavioral Anomaly Detection 2249 

CRS     Collaborative Robotic System 2250 

CRADA    Cooperative Research and Development Agreement 2251 

CSF    NIST Cybersecurity Framework 2252 

CSMS    Cybersecurity for Smart Manufacturing Systems 2253 

DMZ    Demilitarized Zone 2254 

DNAT    Destination Network Address Translation 2255 

FOIA    Freedom of Information Act 2256 

GPO    Group Policy Object 2257 

HDD    Hard Disk Drive 2258 

ICS    Industrial Control System 2259 

IIS    Internet Information Services 2260 

IoT    Internet of Things 2261 

IT    Information Technology 2262 

LAN    Local Area Network 2263 

MFA    Multifactor Authentication 2264 

MTD    Moving Target Defense 2265 

NAT    Network Address Translation 2266 

NCCoE    National Cybersecurity Center of Excellence 2267 

NIST    National Institute of Standards and Technology 2268 

NISTIR    NIST Interagency or Internal Report 2269 

NSA    National Security Agency 2270 

NTP    Network Time Protocol 2271 

OT    Operational Technology 2272 
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OU    Organizational Unit 2273 

PCS    Process Control System 2274 

PI    Process Information 2275 

PLC    Programmable Logic Controller 2276 

RDP    Remote Desktop Protocol 2277 

SP    Special Publication 2278 

SPAN    Switch Port Analyzer 2279 

VDI    Virtual Desktop Interface 2280 

VLAN    Virtual Local Area Network 2281 

VM    Virtual Machine 2282 

VPN    Virtual Private Network 2283 
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Appendix B Build Architectures Diagrams 2284 

 

Figure B-1 Build 1 Architecture Diagram 2285 

  



DRAFT 

NIST SP 1800-10C: Protecting Information and System Integrity in Industrial Control System Environments 126 

Figure B-2 Build 2 Architecture Diagram 2286 
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Figure B-3 Build 3 Architecture Diagram 2287 
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Figure B-4 Build 4 Architecture Diagram 2288 

 


	1 Introduction
	1.1 How to Use this Guide
	1.1 Build Overview
	1.2 Typographic Conventions
	1.3 Logical Architecture Summary

	2 Product Installation Guides
	2.1 Dispel Remote Access
	2.1.1 Host and Network Configuration
	2.1.2 Installation
	2.1.3 Configuration

	2.2 Dragos
	2.2.1 Host and Network Configuration
	2.2.2 Installation
	2.2.3 Configuration

	2.3 Forescout Platform
	2.3.1 Host and Network Configuration
	2.3.2 Installation
	2.3.2.1 eyeInspect 
	2.3.2.2 Forescout Console
	2.3.2.3 eyeSight
	2.3.2.4 eyeSight SecureConnector Agent
	2.3.2.5 ICS Patrol 

	2.3.3 Configuration
	2.3.3.1 eyeInspect 
	2.3.3.2 eyeSight


	2.4 GreenTec-USA
	2.4.1 Host and Network Configuration
	2.4.2 Installation
	2.4.3 Configuration
	2.4.3.1 ForceField HDD
	2.4.3.2 WORMdisk HDD
	2.4.3.3 Samba
	2.4.3.4 OSIsoft PI Server and Database Backups


	2.5 Microsoft Azure Defender for IoT
	2.5.1 Host and Network Configuration
	2.5.2 Installation
	2.5.3 Configuration

	2.6 OSIsoft PI Data Archive
	2.6.1 Host and Network Configuration
	2.6.2 Installation
	2.6.3 Configuration
	2.6.3.1 PI to PI Interface (PCS)
	2.6.3.2 PI System Connector (CRS)
	2.6.3.3 PI Asset Template Analysis Functions and Event Frames
	2.6.3.4 PI Web API
	2.6.3.5 Firmware Integrity Checking


	2.7 Security Onion
	2.7.1 Host and Network Configuration
	2.7.2 Installation
	2.7.3 Configuration

	2.8 TDi ConsoleWorks
	2.8.1 Host and Network Configuration
	2.8.2 Installation
	2.8.3 Configuration

	2.9 Tenable.OT
	2.9.1 Host and Network Configuration
	2.9.2 Installation
	2.9.3 Configuration

	2.10 VMware Carbon Black App Control
	2.10.1 Host and Network Configuration
	2.10.2 Installation
	2.10.3 Configuration

	2.11 Windows Software Restriction Policy (SRP)
	2.11.1 Host and Network Configuration
	2.11.2 Installation
	2.11.3 Configuration
	Appendix A List of Acronyms
	Appendix B Build Architectures Diagrams



	Word Bookmarks
	figure_b_1
	figure_b_2
	figure_b_3
	figure_b_4


